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RINGKASAN

PENGARUH PELATIHAN
PENGGUNAAN PROGRAM MICROSOFT POWERPOINT TERHADAP
KEMAMPUAN GURU (SEBAGAI OUTPU/7), SERTA PERHATIAN SISWA
KELAS VIII (SEBAGAI OUTCOME) DALAM PROSES PEMBELAJARAN
DI SMP KRISTEN PETRA 5 SURABAYA

WIDDY ENDRAYANTO

Selama ini SMP Kristen Petra 5 belum mengoptimalkan pembelajaran
secara multimodal. Padahal pembelajaran multimodal memungkinkan siswa
menerima informasi lebih dari satu bentuk modalitas, baik berupa teks, narast,
animasi, tlustrasi, maupun model visual. Pembelajaran multimodal membuat
perhatian siswa lebih meningkat melalui interaksi secara kognitif dengan model
visual seperti multimedia, hipermedia, maupun robot simulator. Melalui
penggunaan program komputer maka guru memiliki kesempatan untuk
meningkatkan kemampuannya sebagai desainer pembelajaran.

Tujuan penelitian ini menganalisis pengaruh pelatihan penggunaan
program Microsoft PowerPoint terhadap kemampuan guru dalam meningkatkan
perhatian siswa kelas VIII SMP Kristen Petra 5 Surabaya. Selain itu penelitian ini
Jjuga menganalisis objek perhatian dan subjek perhatian.

Rancangan penelitian adalah pra eksperimental yaitu penelitian yang
mencari hubungan sebab akibat dari suatu gejala atau kejadian yang ada.

Sampel penelitian ini adalah 10 guru dan 262 siswa kelas VIII. Kesepuluh

guru tersebut terdiri dari guru tetap maupun guru tidak tetap. Sampel siswa

merupakan populasi siswa kelas VIIL.
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Variabel independennya adalah kemampuan guru sebelum diberi pelatihan
penggunaan program Microsoft PowerPoini. Kemampuan meliputi ranah kognitif,
afektif, dan psikomotorik. Sedangkan variabel dependennya adalah kemampuan
guru setelah diberi pelatihan penggunaan program Microsofi PowerPoint.

Tekmik analisis yang dipakai adalah uji t berpasangan, dengan tingkat
signifikansi (a ) = 0,05. Analisis tersebut berdasar hasil alat pengolah data yaitu
program Microsoft Fxcel dan program SPSS versi 14.0.

Hasil penelitian menunjukkan bahwa, pertama pelatihan penggunaan
program Microsofi Powerl’oint mempengaruhi kemampuan baik kognitif, afektif,
maupun psikomotorik guru dalam proses pembelajaran. Kedua, penggunaan
program Microsofi PowerPoint dalam proses pembelajaran mempengaruhi
perhatian siswa. Selain itu, hasil penelitian menunjukkan bahwa salah satu dan
keempat aspek objek perhatian mendapat penilaian lebih baik dari populasi siswa.
Sedang untuk keempat aspek subjek perhatian mendapat penilaian yang sama dari
populasi siswa.

Manfaat dari penelitian yaitu dapat memberi kontribusi berupa hasil
penerapan iimu di Program Pengembangan Sumber Daya Manusia Pasca Sarjana
Universitas  Airlangga Surabaya. Secara praktis hasil penelitian ini dapat
diimplementasikan di lingkungan SMP Kristen Petra 5 dan yang berimplikasi
dengan PPPK Petra Surabaya dalam mengambil kebijakan.

Keterbatasan penelitian ini adalah: pertama, tidak ada kelompok kontrol.
Kedua, waktu yang tersedia untuk pelatihan hanya 2 kali pertemuan, sehingga
dimungkinkan kurang optimalnya guru dalam persiapan PBM menggunakan

program Microsoft PowerPoint. Ketiga, tidak semua aspek perhatian diolah secara
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crosstab, melainkan hanya beberapa aspek perhatian saja yang dipandang cukup
mewakili dan segi karakteristiknya.

Dengan demikian dapat disimpulkan bahwa terbukti ada peningkatan
kemampuan guru dalam proses pembelajaran serta ada peningkatan perhatian

siswa kelas VIII dalam proses pembelajaran di SMP Kristen Petra 5 Surabaya.
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SUMMARY

THE EFFECT OF MICROSOFT POWERPOINT TRAINING PROGRAM
TOWARD THE CAPABILITY OF THE TEACHERS (AS AN OQUTPUT), AND
THE ATTENTION OF THE GRADE VIII STUDENTS (AS AN OUTCOME) IN

LEARNING PROCESS IN PETRA § CHRISTIAN JUNIOR HIGH SCHOOL
SURABAYA

WIDDY ENDRAYANTO

Petra 5 Christian Junior High School has not optimized the multimodal
learning so far. The multimodal learning enables students to receive information
using more than one type of modality, such as texts, narratives, animations,
illustrations, and visual models. The multimodal learning enhances the attention
of students through a cognitive interaction with visual models such as multimedia,
hypermedia, or robot simulator. By using computer programs, teachers have the
opportunity to enhance his/her capability as learning designers.

The objective of this research 1s to analyze the effect of the Microsoft
PowerPoint training programs toward the capability of the teachers in enhancing
attention of the grade VIII students in Petra 5 Christian Junior High School. This
research also analyzes the object and the subject of attention.

The research methodology is pre-experimental which is a research seeking
the causal relationship of a phenomenon or an event.

The samples of this research are 10 teachers and 262 grade VIII students.
Those ten teachers are permanent as well as temporary ones. The samples of the
students are the population of grade VIII students.

The independent variable is the capability of the teachers before attending
the Microsoft PowerPoint traiming program. The capability includes the cognitive,
affective, and psychomotor domains. And the dependent variable is the capability
of the teachers after attending the Microsofi PowerPoint training program.

The analysis technique used is the paired t test, with significance level (a)
= 0.05. This analysis is based on the result of the data processing instruments
namely Microsoft Excel program and SPSS program version 14.0.

Firstly, the result of this research reveals that the Microsoft PowerPoint
training program influences the cognitive, affective, or psychomotor capabilities
of the teachers in the learning process. Secondly, the application of Microsoft
PowerPoint program in learning process influences the attention of the students.
The result of this research also reveals that one of the four aspects of the attention
objects gets a better assessment from the student population. While the four
aspects of the attention subjects get an equal assessment from the student
population.

The advantage of this research is to contribute an application of science in
the Post Graduate Program of Human Resources Development in Universitas
Airlangga Surabaya. Practically the result of this research can be implemented in
Petra 5 Christian Junior High School and implicitly influence the PPPK Petra
Surabaya in making a policy.

X
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The limutations of this research are: first, there is no control group. Second,
the time available for training is only 2 meetings, so there ts a possibility that
teachers did not prepare the PBM using Microsoft PowerPoint program optimaily.
Third, not all observation aspects are processed using crosstab, only some aspects
which are considered characteristically representative enough.

Conclusively, it is proven that there is an enhancement in the capability of
the teachers in the learning process and there is an enhancement in the attention of

the grade VII students in the learning process in Petra S Christian Junior High
School Surabaya.
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ABSTRACT

THE EFFECT OF THE MICROSOFT POWERPOINT TRAINING PROGRAM
TOWARD THE CAPABILITY OF THE TEACHERS (AS AN QUTPUT), AND
THE ATTENTION OF THE GRADE VIII STUDENTS (AS AN QUTCOME) IN

LEARNING PROCESS IN PETRA 5 CHRISTIAN JUNIOR HIGH SCHOOL
SURABAYA

WIDDY ENDRAYANTO

This research aims to analyze the effect of the Microsoft PowerPoint
training program toward the capability of teachers in enhancing the attention of
the grade VIII students in Petra S Christian Junior High School. This research also
analyzes the object and the subject of attention.

The samples of this research are 10 teachers and 262 grade VIl students.

The research methodology used is pre-experimental using paired t test
analysis technic with significance level (a) = 0,05

This research shows that the Microsofi Powerpoini training program
influences the cognitive, affective, or psychomotor capability of the teachers in
the leaming process. While the use of Microsoft Powerpoint program in the
learning process influences the attention of the students. The result also reveals
that one of the four aspects of the attention objects gets a better assessment from
the student population. And the four aspects of the attention subjects get an equal
assessment from the student population. This research recommends that teachers
should train themselves in order to enhance their capability. Afterwards advance
training can then be offered to the teachers. If the stages are not arranged like that
then there will be many disadvantages.

The limitations of this research are the absence of control group, the

infrequency of training, and not all aspects of attention are processed using
crosstub.

Key words: training, cognitive, affective, psychomotor, capability, attention.
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BAB 1

PENDAHULUAN

i.1 Latar Belakang Penelitian

Kemampuan guru baik dalam pemahaman, sikap dan ketrampilan
dalam pembelajaran selama ini sebagian besar masih menggunakan
pendekatan  tradisional  yaitu  menggunakan media  instruksional  secara
monomodal yaknt siswa menerima informasi vang disajikan hanya satu
bentuk modalitas. Hal demikian kurang membantu siswa dalam memahami
suatu penjelasan. Pada sisi vang lain pembelajaran secara multimodal, siswa
menerima informas) lebih dart satu bentuk modalitas, berupa paduan antara
teks. narasi, animasi, ilustrast, dan model visual.

Pembelajaran menggunakan multimodal ketika siswa berinteraksi
secara kogmitif dengan model visual seperti multimedia, hipermedia, dan
robot simulator.  Ketika siswa belajar lewat multimodal, siswa lebih
tewstnutasy dan mennlihy usalia belajar yang febih unggs (Gabe, 1997 dalam
Pranata, 2006).

Pembelajaran menggunakan multimodal in1 lebth membaniu siswa
dalam memahami suatu pemjelasan serta menggunakan seluruh level
kemampuan kognitifnya untuk memecahkan masalah. Hal demikian sejalan
dengan pendapat Baugh, Achsin dalamy Azhar (2005), yang menyatakan
bahwa perbandingan perolehan hasil belajar melalui indera pandang dan

indera dengar sangat menonjol perbedaannya. Perolehan hasil belajar

g
1
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seseorang melalur indera pandang kurang lebib 90%, sedang melalui indera
dengar kurang lebih 5%, sedang Kurang lebih > Yo sisanya menggunakin
indera lainnya. Namun demikian media instruksional dapat berfungsi efektif
bila diwujudkan melalui metode konstruktivistik dimana perancangan media
harus berbasiskan pembelajaran, bukan sekedar siswa dapat menyerap dan
mengingat sebanyak-banyaknya informasi. Dalam pengertian ini bahwa
pembelajaran menpgunakan media secara konstruktvistik adalah suatu proses
memberdayakan siswa agar siswa belajar bagaimana belajar.

Dengan  adanva propram komiputer  sebagai  tekaolopt  dalam
pembelajaran yang memodernisir media instruksional, maka guru dapat
menggunakan teknologi terscbut. Oleh karena itu pembelajaran menggunakan
media  multimodal memiliki  keunggulan dalam  mendorong guru
memngkathan  kemampuoanoya sehagn desaner pembelagaran (Pranata,
2006). Selain itu, peran guru dalam menggunakan dan mengarahkan
penggunaan media berbasis komputer akan sangat menentukan kualitas hasil
pembelajaran bermedia. Dalam konteks demikian, selama ini pembelajaran di
SMP Kristen Petra 5 sebagian besar masih menggunakan pendekatan
tradistonal, vaitu pembelajaran mengpunakan media mstruksional secara
monomodal. Kondisi demikian tentu tidak kondusif dan siswa belum
menjalani proses belajar yang mengoptimalkan seluruh level kemampuan
kognitifnya.

Maka upaya pemberdayaan guru agar nantinya guru memiliki
kemampuan  dalam  menguasai teknologi komputer  schingga  dapat

menghasilkan media instruksional berbasis komputer, merupakan perhatian
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dalam pengembangan sumber daya manusia di SMP Kristen Petra 5
Surabaya. Pemberdayaan tersebut perlu  diwujudkan  melalui pelatihan
penggunaan program komputer.

Berdasar data bulan Oktober 2005, sebanyak 27,66% guru SMP
oristen Petra § Surabayn belum memiliki kemampuan menggunakan program
Microsoft PowerPoint. Hal itu dapat dilihat dalam tabel [.1. Sedangkan
72,34% guru yang sudah menubki kemampuan menggunakan  program
Aficrasoft PowerPomt belum secara optimal memanfaatkan kemampuannya

tersebut dalam pembelajaran.

Tabel 1.1, Data Guru SMP Kristen Petra 5 Surabaya

I PENGGUNAAN POWERPOINT

NO STATUS GURU | JML | SUDAH BISA | BELUM BISA
|, JUML | % | JUML | %

{ | GURU TETAP 27 25 5319 2 426
T2 | GURU TIDAK TETAP "J,r_?.o'_ 9 | ous T 23,40
JUMLAH [ 47 3 1734 13 | 2766

Sumber informasi:
Humas SMP Krislen Petra 5 Surabava
Kemungkinan kendala tersebut karena setiap kelas belum tersedia
perangkat komputer beserta LCD (Liquid Crystal Display) projector. Sedang
ruangan yang memiliki perangkat komputer beserta LC/1) Projector masih
sebatas satu ruang serba guna, yang pemakaiannya harus bergantian untuk
dua puluh kelas. Namun sarana dan prasarana berupa satu ruang laboratorium
komputer dengan empat puluh perangkat komputer layak pakai, telah
memadat untuk penvelenparaan pelatihan
Hal wama sebelum penyelenggaraan pelatihan adalab penentuan

materi program komputer manakah yang akan diberikan. Dari berbagai
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program komputer serta model visual yang ada, maka sementara ini program
Microsof  PowerPoine merupakan pilthan vang  cokup memadai  untuk
pengadaan multimedia yang, dapat digunakan sebagai media instruksional
secara multimodal. Dengan demikian, selesai pelatihan penggunaan program
Microsof  PowerPoint,  diharapkan secara  berangsur  pembelajaran
menggunakan media instruksional secara multimodal akan mengganti
pembelajaran sceara monomodal yang kurang memben stunulast bag siswa.

Media instruksional yang kurang memberi stimulasi kepada siswa
memben dampak berkurangnya perhatian siswa terhadap penyajian informasi
saat pembelajaran. Hal ity didukung Suryabrata (2005), yang berpendapat
bahwa munculnya perhatian dipengaruhi oleh dua hal: objek yang memiliki
daya tarik perhatian, dan subjek dengan segala hal yang dimilikinya.

Kondisi di atas terdapat berbagai permasalahan yang perlu
diselesaikan dengan mencari solusinya. Namun dalam hal ini pembatasan

terhadap suatu permasalahan diperlukan untuk tujuan penelitian.

I.2. Rumusan Masalah Penelitian
1. Apakah pelatihan penggunaan program Microsofi PowerPoint dapat
mempengaruhi kemampuan baik kognitif, afektif, maupun psikomotorik
guru dafam proses pembelajaran?
2. Apakah penggunaan program Microsoft PowerPoint dalam  proses

pembeiajaran dapat mempengaruhi perhatian siswa?
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1.3. Tujuan Penelitian
1.3.1. Tujuan Umum
Menganalisis pengaruh pelatihan penggunaan program Microsoft
PowerPomt terhadap kemampuan guru dalam mentingkatkan perhatian
siswa kelas VI SMP Kristen Petra 5 Surabava
1.3.2. Tujuan Khusus
1.3.2.1. Menganalisis pengaruh pelatthan penggunaan program
Microsofi  PowerPoint terhadap  kognmitif, afekuf, dan
pothomatorik parg dalam pembelagaran
1.3.2.2. Menganalisis media pembelajaran menggunakan program
Mrcrosoft PowerP ot sehagal olyek perhatan,
1.3.2.3. Menganalisis aspek dalam diri siswa sebagai subjek yang
terkait dengan perhatian terhadap media  pembelajaran
mengpunakan program Mcrosoft Poveerl o
1.3.2.4. Menganalisis pengaruh penggunaan media pembelajaran
mengpunakan  program  Alicrosoft Powerlomt lerhadap

peningkatan perhatian siswa.

1.4 . Manfaat penelttian
b Seeara teonts penchitian mi akan membenr hontnbuse hasil pencrapan
ilmu di Program Pengembangan Sumber Daya Manusia Pasca Sarjana
Universitas Airlangga Surabaya.
2. Secara praktis hasil penelitian ini dapat digunakan oleh SMP Kristen

Petra 5 Surabaya untuk mengambil kebyjaksanaan.
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BAB 2

TINJAUAN PLISTARA

Media Pembeligaran Berbasis Kompuiter

Sistern informasi dirancang untuk memudahkan daiam menyusun, dan
mengelola berbagai informasi yang diperlukan. Dalam operasionalnya,
sistem informasi didukung dengan perangkat [unak berupa program-
program.  Salah  sutu program  vang  ada  adalah  program  Aficrosoft
PowerPoint, yakni program yang dirancang untuk menyiapkan media
presentasi. Presentasi baik dalam seminar, lokakarya maupun dalam proses
belajar mengajar.

Dalam pembelajaran, media presentasi sering disebut sebagai media
instruksional, seperti yang diungkapkan oleh Pranata (2006) sebagai berikut:

“Pandangan-pandangan model pembelajaran bermedia mempe-

ngaruhi bagaimana media instruksional dirancang dan digunakan

dalam pembelajaran.”

Media instruksional vyang berbasis program komputer memiliki
kelebihan terutama dapat dipakai dalam pembelajaran seeara multimodal.

Media pembelajaran berbasis program Microsoft Powerfomt dapat
memvisualisasikan data maupun gagasan melalui hurut, gambar, animasi,
ilustrasi, dan foto secara menarik dengan menggunakan fasilitas efek
tampilan. Huruf, gambar animasi, ilustrasi, dan foto merupakan objek yang
dapat didesain hingga menghasilkan media presentasi untuk pembelajaran

berupa slide yang sangat menarik. Bahkan Microsofi  Powerfoint
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menyediakan sarana pendukung berupa suara (aidio) untuk memberikan
effect atau ilustrasi saat sfide tersebut ditayangkan. Kenyataan ini seperti
yang diungkap oleh Arsyad Azhar (2005) sebagai berikut:

"Perkembangan ilmu pengetahuan dan teknolog: semakin men-

dorong upaya-upaya pembaharuan dalam pemanfaatan hasil-
hasil teknologi dalam proses belajar.”

Sehingga Kemp & Dayton dalam Azhar (2005), berupaya
mengelompokkan media dalam delapan jenis, yaitu: media cetakan, media
pajang, overchad transpuracies, vekaman  audiotape, seri slide  dan
Silmstrips, penyajian mudti-image, rekaman video dan film hidup, dan
komputer.

”...mengelompokkan media dalam delapan jenis, yaitu

media cetakan, media pajang, overhead transparacies,

rekaman audiotape, sert slide dan {ilmstrips, penyajian

muiti-image, rekaman video dan film hidup, dan komputer.”

Komputer dapat merckam, menganalisis, dan memberikan reakst
kepada respon yang di-inpur oleh pemakai atau siswa. Komputer untuk
pendidikan dikembangkan dalam beberapa format yang dirilis dan praktis,
antara lain tutorial, simulasi, permainan, discovery serta tayangan yang
menggunakan program Microsoft Power Point.

Benkut disajikan bagaimana ciri-ciri umum tentang batasan media
pendidihan menunut Azhar Arsyad.

1. Media pendidikan memiliki pengertian fisik yang dewasa ini dikenal
sebagai perangkat keras (hurdware), vaitu sesuatu benda vang dapat

dilihat atau diraba dengan panca indera.
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2. Media pendidikan memiliki pengertian nonfisik yang dikenal sebagai
perangkat lunak (soffware), yaitu kandungan pesan yang terdapat dalam
perangkat keras vanp merupakan isi vang ingin disampaikan kepada siswa.

3. Penekanan media pendidikan terdapat pada visual dan audio.

4. Media pendidikan memilikt pengertian alat bantu pada proses belajar baik
di dalam maupun di luar kelas..

5. Media pendidikan digunakan dalam rangka komunikasi dan interaksi guru
dan siswa dalam proses pembelajaran.

6. Media pendidikan dapat digunakan secara massal (misainya: radio,
telewist), kelompok besar dan kelompok kecil (misaloya (ilm, stide, video,
OHP), atau perorangan (misalnya: modul, komputer, radio fape/ kaset,
video recorder).

Memperhatikan batasan tentang suatu media pendidikan di atas, maka
salah satu fungsi utama media pembelajaran adalah sebagai alat bantu mengajar
yang turut mempengaruhi iklim, kondisi, dan lingkungan belajar yang ditata dan
diciptakan guru.

Hamalik dan Azhar (2005), mengemukakan bahwa pemakaian media
pembelajaran dalam proses belajar mengajar (PBM) dapat membangkitkan
keinginan dan minat yang baru, membangkitkan motivasi dan rangsangan
kegiatan belajar. Bahkan membantu keefektifan proses pembelajaran dan
penyampaian pesan serta isi pelajaran, meningkatkan pemahaman, menyajikan
data dengan menank dan terpercaya, memudahkan penafsiran data dan

memadatkan informasi.
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Menurut Kemp & Dayton dalam Azhar (2005), bahwa media pembelajaran
dapat memenuhi tiga fungsi utama: 1. Memotivasi minat dan tindakan; 2.
Menyajikan informasi; dan 3. Memberi instruksi.

tincyclopedia of  Fducational  Research dalam Hamalik dan  Azhar

menyebutkan manfaat media sebagai berikut:

1" Meletakkan dasar-dasar yang konkret untuk berpikir, oleh karena itu
mengurangi verbalisme.

2. Memperbesar perhatian siswa.

3. Meletakkan dasar-dasar yang penting untuk perkembangan belajar, oleh karena
itu membuat pelajaran lebih mantap.

4. Memberikan pengalaman nyata yang dapat menumbuhkan kegiatan berusaha
sendiri di kalangan siswa.

5. Menumbuhkan pemikiran yang teratur dan kontinyu, terutama melalul gambar
hidup.

6. Membantu tumbuhnya pengertian dan perkembangan kemampuan berbahasa,

7. Memberikan pengalaman yang tidak mudah diperoleh  dengan cara lain, dan

membantu efisiensi dan keragaman yang lebih banyak dalam belajar.

Levie & Levie dalam Azhar (1975), menyimpulkan bahwa stimulus visual
membuahkan hasil belajar yang lebih baik untuk tugas-tugas seperti mengingat,
mengenali, mengingat kembali, dan menghubung-hubungkan fakta dan konsep.
Sedangkan Paivio dalam Azhar (1975), memiliki konsep dual coding hypothesis
(hipotesis koding ganda), yang menyatakan bahwa ada dua sistem ingatan
manusia. Satu untuk mengolah simbol-simbol verbal kemudian menyimpannya

dalam bentuk proposisi image, dan yang lainnya untuk mengolah image nonverbal
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yang kemudian disimpan dalam bentuk proposisi verbal.

Yunus dalam Azhar (2005), menyebutkan bahwa orang vyang

mendengarkan saja tidaklah sama tingkat pemahaman dan lamanya pemahaman

bertahan, Apa yang dipahanunya oleh mercka yang melilat saja, akan kalab jaub

dibandingkan dengan mereka yang melihat dan sekaligus mendengarkan.

Lebih rinci lagi dari Yunus, Baugh dalam Achsin dalam Azhar (20035),

menyatakan bahwa:

“Perbandingan pemerolehan hasil belajar mefalui indera pandang
dan indera dengar sangat menowol perbedaannya. Pemerolchan hasil
belajar seseorang melalui indera pandang kurang lebih 90%, sedang
melalui indera dengar kurang lebih 5%, sedang kurang lebih 5% sisa-
nya menggunakan indera lainnya.”

Levie & Lentz dalam Azhar (2005), menyebutkan bahwa fungsi

pembelajaran, Khususnya media visual, ada 4 yaitu:

lFungst Atensi. Media menarik dan mengarahkan perhatian siswa  untuk
berkonsentrast kepada isi pelajaran. Bahkan media digunakan pada awal
pelajaran untuk menarik perhatian awal,

Fungst Afektif. Gambar atau lambang visual dapat menggugah emosi dan
sikap siswa, misalnya informasi yang menyangkut masalah sosial.

Fungst Kognitif: Gambar atau lambang visual memperlancar pencapaian
twuan  untuk  memabann dan mengingat  mformasi  atau pesan yang
terkandung dalam gambar.

Fungs1 Kompensatoris. Media visual memberikan konteks untuk memahami
teks, membantu siswa yang lemah dan lambat dalam memahami isi pelajaran

yang disampaikan dengan teks atau disajikan secara verbal.
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Berikut keuntungan komputer terkait dengan media pembelajaran:

. Memberikan ikl yang bersilat alektif’ dengan cara yang lebib individual,
tidak lupa, idak bosan, sabar dalam menjalankan instruksi.

2. Merangsang siswa mengerjakan latihan, melakukan kegiatan laboratorium
atau simulasi karena tersedianya animasi grafik, warna, dan musik yang
dapat menambah realisme.

3. Menyesuaikun dengan tinghut penpuasaain siswa dilaim menggunakannyn,

4. Memantau perkembangan pembelajaran siswa karena memiliki fungsi
merekam.

5. Dapat mengendalikan peralatan lain seperti compac dise, video tape, dan
lain-fain.

6. Dengan bantuan 1.CD projector, dapat ditayangkan pesan-pesan ke layar

lebar untuk dilihat oleh beberapa orang dalam kelompok atau kelas.
2.2, Pelatihan
Nadler dan Nadler (1987), mengatakan bahwa:

"Pelatihan merupakan pembelajaran yang disediakan pengusa-
ha kepada pekerja berkaitan dengan-pekerjaan mereka saat ini.”

Sedangkan Tail & Flall (1998), memiliki kesimpulan bahwa:

"Dengan mengkombinasikan berbagai macam faktor seperti
teknik pelatihan yang benar, persiapan dan perencanaan
yang matang, serta komitmen lerhadap esensi pelatihan,
organisasi dapat mencapai keberhasilun dalam persaingan
pasar yang sangat ketat.”
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Adapun Sofo (1999), menyatakan babwa:

“Pelatihan dalam format apapun masih dibutuhkan,
karena memberikan inspirasi dan bersifat transformatif.”

Lebih lanjut Sofo menyatakan bahwa pelatihan muncul dalam siklus
pembelajaran yang dimuiai dari kesadaran. Melalui kesadaran inilah pelatih
membantu khen untuh memperjelas apa vang benar-benar ditnpinkan klien
DDan Mathis Robert I... Jackson John H., (2001}, menyatakan bahwa;

“Pelatihan kerja-ketrampilan (job-skill training) adalah bagian
dari pelatihan dan pengembangan Sumber Daya Manusia
(SDM). Pelatihan berkesinambungan diperlukan untuk
tanggap terhadap perubahan teknologi. Hal itu berkenaan

dengan pengembangan semua tenaga kerja dimana diperlukan
untuk menviapkan organisasi menghadapi tantangan ke depan.™

Soekidjo Notoatmodjo (2003), menyatakan bahwa:

“Kemampuan sumber daya manusia harus terus menerus
ditingkatkaP seirama dengan kemajuan dan perkembangan
organisasi.
Menurutnva bahwa siklus pendidikan dan pelatihan secara paris besar
meliputi;
I Analisis Kebutuhan Pendidikan dan Pelatihan. Dalam tahap im terdapat
analisis organisasi, analisis pekerjaan, dan analisis pribadi.
2 Menetapkan Tuojuan Tujuannva  adalah  adanyva perabahan perilaku
(kemampuan). Maka perumusan tujuan harus dalam bentuk tingkah laku
(behavior vbjectives).

3. Pengembangan Kurikulum. Upaya menyediakan materi dan metode belajar

i . oy
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mengajar yang sesuai dengan kebutuhan.

4. Persiapan Pelaksanaan Diklat. Kegiatan persiapan meliputi kegiatan
administrasi.

5. Pelaksanaan Pendidikan dan Latihan. Pelaksanaan yang terus dimonitor
oleh penanggung jawab harian.

6. Evaluasi Kegiatan, Evaluasi terhadap proses dan hasil kegiatan sejauh

mana pendidikan dan pelatihan dikuasasi peserta.

Pada bagian yang lain Syarif Rusli (1991), menyatakan bahwa:
“Kebutuhan latihan adalah selisih antara sikap dan
ketrampilan yang diminta dengan sikap dan ketrampilan
yang telah dimiliki, atau selisih antara prestasi yang
diminta dengan prestasi yang telah dicapai.”
2.3, Hasil Belajar
Menurut  Bloom, beberapa  indikator dan  kemungkinan cara

mengungkapkan hasil pembelajaran dalam kawasan (ferm): kognitif, afektif,

dan psikomotor adalah seperti dalam tabel 2.1

Tabel 2.1 Hasil Belajar Menurut Bloom

JENIS HASIL Ay CARA
BELAJAR INDIKATOR PENGUKURAN
A. KOGNITII
Pengamatan/ Dapat inenunjukkan/ Tugas/ les/ observasi
perseptual membandingkan/ menghu-
bungkan
Hafalan/ ingatan Dapat menyebutkan/ Pertanyaan/ tugas/ tes
Menunjukkan lagi
Pengertiun/ Dapat menjelaskan/ Pertanyaan/  persoualan/
pemahaman Mende-finisikan dengan tes/ tugas
kata-kata sendiri,
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. Program/ ‘- Dapat memberikan contoh/ [Tugasf’ persoalan/ tes |
penggunaanan - menggunakan dengan '
tepat! memecahkan
i | masalah !
| Alisis ' Dapat menguraikan/ | Tugas/ persoalan/ tes
] mengklasnﬁkas:kan !
' Sintesis | Dapat menghubungkan/ ' Tugas/ persoalan/ tes
' " menyimpulkan/ mengge- | !
neralisasikan
Evaluasi Dapat menginterpretasikan/ [ Tugas/ persoalan/ tes
' memberikan kritik/
- memberikan perumbangan; :
| penilaian o ,'
B. AFEKTIF | ]
i !
\ 1
Penerimaan ‘ Bersikap menenima ! Pertanyaan/ tes/ skala
: | Menyetujui atau sebaliknya | sikap
Sambutan | Bersed:ia terlibat/ | Tugas/ observasi/ tes
‘part:snpasnf memanfaatkan
atau sebaliknya. .-
Penghargaan/ | Memandang penting/ ' Skala penilaian/ tugas/
apresiasi bernilai/ berfaedah/ indahy . observasi :
; harmonis/ kagum atau
sebaliknya
Intemalisasi/ Mengakul’ mempercayai/ | Skala  sikap/  tugas
pendalaman meyakinkan atau sebalik- | ekspresif/ proyektif
! nva
| Karakterisasi/ : Melembagakan/ membiasa- | Observasi/ tugas !
penghayatan kan/menjelmakan dalam ekspresy/ proyektif
pribadi dan perilakunya
| | schari-hari
r i - - T A
| C. PSIKOMOTOR |
Ketrampilan Koordinasi mata, tangan | Tugas/ observasi/ tes/
+ bergerak/ bertindak. * dan kaki tindakan [
Ketrampilan | Gerak, mimik, ucapan | Tugas/ observasi/ tes/ :
ekspresi verbal dan tindakan

non verbal

1

Sedangkan menurut Horward Kingsley dan Gagne dalam Sudjana,

bahwa:

"Hasil belajar sebagai objek penilaian dimana ada tiga
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macam hasil belajar, meliputi: ketrampilan dan
kebiasaan; pengetahuan dan pengertian; sikap dan
cita-cita. Dan lima kategori hasil belajar: informasi
verbal, ketrampilan intelektual, strategi kognitif, sikap,
dan ketrampilan motoris.”
Menurut Gagne paling sedikit ada limg macam perubahan perilaku
akibat pengalaman antara lain: |
I. Belajar responden. Perubahan perilaku akibat perpasangan antara
stimulus tak terkondisi dengan stimulus terkondisi.
2. Belajar kontiguitas. Perubahan perilaku karena dua peristiwa
dipasangkan satu dengan yang lain dalam suatu waktu.
3. Belajar operant. Perubahan perilaku disebabkan oleh konsekuensi-
konsekuensi perilaku.
4. Belajar observasional. Perubahan perilaku karena hasil kegiatan
observasi dan kejadian-kejadian.
5. Belajar kogmtit. Perubahan perilaku karena melihat dan memahami
peristiwa-peristiwa. Dengan insight manusia belajar menyelarm

pengertian,
2.4, Perhatian
Menurut Suryabrata (2005), bahwa:

“Hal-hal yang dapat mempengaruhi adanya suatu perhatian
ada dua. Pertama, objek yang menjadi perhatian. Kedua,
subjek yang memperhatikan.”

a. Perhatian dipandang dari segi objek.

Hal yang menarik perhatian adalah hal yang keluar dari konteksnya
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atau dengan kata lain, hal yang menarik adalah hal yang lain dari pada
yang lain.
Hal yang lain tersebut bisa timbul dari hal sebagai berikut:
I. Warna. Warng dominan di sckitar warma yang hampir sama akan
terkesan lebih menyita perhatian daripada warna lain yang hampir

sama.

~J

Gerakan. Gerakan orang yang mondar mandir di sekitar orang vang
duduk dengan tenang, akan lampak lebih menuntut perhatian daripada
orang yang duduk dengan tenang,

3. Cahaya. Lampu yang menyala secary berkedip di antara lampu lain
yang menyala secara tetap akan lehih dominan dalam menyedot
perhatian daripada lampu yang menyala secara tetap,

A Susunan. Fultsan dalan klan yang tertulis secara terbalik akan lebih
meminta perhatian dari pada tulisan yang ditulis sepertt biasanya,

5. Kebiasaan, Keadaan, sikap, sifat, cara berpakaian yang lain dar
biasanya akan lebih menarik perhatian.

6. Kejadian tiba-tiba. Ha| yang sifatnya mendadak datang dan lenyapnya

aka el mienanh pi b,

b. Perhatian dipandang dari segi subjek yang memperhatikan.
Hal yang menarik adalah ha yang sangat bersangkut paut dengan
pribadi subjek. Hal yang bersangkut paut dengan subjek antara fain:
I. Kebutuhan. Contoh, obat merupakan kebutuhan bagi orang vang sakit
Informasi tentang perumahan merupakan kebutuhan bagi yang mau
membeli rumah.

ANTO
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RNegemaran. Bulu tangkis merupakan cabang olah raga yang digeman
bagi orang yang gemar dengan olah raga tersebut. Wayang merupakan
seni pertunjukkan tradisional yang digemari bagi yang suka dengan
kesentan tersebut.

3. Pekerjaan atau keahlian. Berita tentang penemuan benda kuno akan
diminati bagi ahli scjarah, Pelatihan keschatan akan lebih diperhatikan
oleh perawat.

4. Sejarah hidup sendiri. Berita tentang UGM akan diminati oleh alumni

UGM. Berita tentang Surabaya akan diminati oleh arek-arek Surabaya.

Aktivitas yang melibatkan perhatian secara intensif akan lebih

sukses dalam meningkatkan prestasi. Sedangkan perhatian secara spontan
akan lebih lama pengaruhnya daripada perhatian sengaja dalam

meningkatkan prestasi. Dari uraian di atas dapat digambarkan kerangka

teoritisnya sehagai berikut

PROCESS OUTPUT OUTCOME

KEMAMPUAN .
PEMBELAJARAN PERHATIAN
GURE SISWA

Gambar 2.1, Kerangka Teoritis dart Tinjauan Pustaka
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BAB 3
KERANGKA KONSEPTUAL

DAN
HIPOTESES PENELITIAN

3.1 Kerangka Konseptual

Kerangka konseptual penelitian ini adalah sebagai berikut:

PELATIHAN |C—_>| KEMAMPUAN

GURU
,” ‘\\ f
+1Q, EL SI >

f
! +BAKAT \
\ +MINAT L
_ + PENDIDIKAN
N ¢
e L
KETERANGAN:

——— Vanabel yang Diteliti
............. - Vanabel Luar yang Tidak Diteliti

Gambar 3 1 Keranpka Konseplual Pencelitiain

Kerangka konseptual di atas dijelaskan scbagai berikut. Pelatihan
dapat meningkatkan kemampuan. Demikian pula IQ (/nfelligence Quotient),
Ll (hmottonal Ttellygent), SU(Spirttual Intelligence) serta bakat, minul, dan

pendidikan, berperan pula dalam meningkatkan kemampuan seseorang,

Dalam hal 1m penehitian akan memfokuskan pada pelatihan.

Sedangkan 1Q (/melligence  Quotient), El (Emational  [ntelligenn), Sl
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(Spiritual Intelligence), bakat, minat, dan pendidikan tidak diteliti.

Dimungkinkan, bahwa dari hasil pelatihan, guru akan menghasilkan

outcome berupa meningkatnya perhatian siswa dalam mengikuti

pembelapicin dengan menppanahan MP?
3.2 Hipotesis Penelitian

1. Pelatihan penggunaan program Microsofi Powerloint mempengaruhi
kemampuan batk kogmuf, afektl, maupun psikomotorik gury dalam
proses pembelajaran

2. Penggunaan program Microsofi PowerPoint dalam proses pembelajaran

mempengaruhi perhatian siswa kelas VIII.
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BAB 4.

MATERTI DAN METTOD PENELITIAN

4.1. Rancangan Penelitian yang Digunakan
Rancangan penelitian ini adalah pra eksperimental yaitu kegiatan
penelitian yang mencari hubungan sebab akibat darl suatu gejala atau
kejadian yang ada. Penelitian untuk menemukan penjelasan bagaimana
pelatihan penggunaan program Microsofi  PowerPoint dapat meningkatkan

kemampuan guru dalam proses belajar mengajar. Selanjutnya, penelitian

observasi juga digunakan untuk memberi gambaran tentang peningkatan
perhatian siswa yang telah mengikuti pembelajaran yang menggunakan
media instruksional berbasis program Aicrosofi PowerfPoint

Penelitian pra cksperimental ini menggunakan dua tahap kegiatan.
Tahap pertama, pembuatan modul tentang penggunaan program Microsoff
PowerPoint dalam proses pembelajaran. Materi modul disusun dari
beberapa buku sumber yang berisi tentang AMicrosofi Powervint serta hasil
diskusi dengan 2 instruktur dari Bina Satya Wacana. Materi yang terkumpul
dikemas disesuaikan dengan kebutuhan proses pembelajaran serta
memperhatikan kondisi peserta pelatihan. Modul memuat teori serta lembar
kerja pembuatan s/ide menggunakan Microsoft PowerPoint. Selain modul,
dibuat pula perangkat prefest dan postiest tentang program Microsofi
PowerPaoint.

Pada tahap kedua ini ada tiga sesi kegiatan. Sesi pertama, guru

diberi pretest tentang program Microsoft PowerPoint. Hal ini untuk
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mengetahui kemampuan awal sebelum guru diberi pelatihan. Sesi kedua,
guru diberi perlakuan berupa pelatihan tentang penggunaan program
Microsoft PowerPoint. Kegiatan ini dilaksanakan dua kalj pertemuan yang
masing-masing pertemuan selama 90 menit, bertempat di laboratorium
komputer sekolah. Sesi ketiga, guru diberi positest tentang program
" Microsoft  PowerPoint. Materi postiest diberikan setelah guru mengikuti
pelatihan. Materi postzest isinya sama dengan materi prefest.

Hasil positest akan dibandingkan dengan hasil pretest. Kegiatan
membandingkan dilakukan untuk mengetahui perkembangan kemampuan
guru setelah diberi pelatihan (output).  Tahap selanjutnya, dilakukan
kegiatan untuk mengetahui pengaruh kemampuan guru dalam menggunakan
MPP terhadap perhatian siswa (outcome),

Kegiatan tersebut dirancang sebagai berikut. Dari ketiga belas guru
yang mengikuti pelatihan akan diambil satu guru yang memperoleh hasil
penilaian terbaik. Selanjutnya guru yang terpilih tersebut diberi kesempatan
melaksanakan pembelajaran sesuai bidang studi yang diajarkan dengan
menggunakan media instruksional berbasis program Microsoft PowerPoint.

Sedangkan siswa yang akan diajar oleh guru yang terpilih, terlebih
dahulu diberi prerest tentang aspek objek perhatian dan aspek subjek
perhatian.

Setelah siswa diberi pretest, langkah berikutnya adalah siswa
mendapat layanan dari guru yang terpilih, berupa pembelajaran sesuai
bidangnya dengan menggunakan program Microsoft PowerPoint.  Setelah

siswa mengikuti pembelajaran, kepada mereka diberikan postiest dengan isi
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materi yang sama dengan prefest. Selanjutnya, hasil posttest dan pretest
dibandingkan untuk  mengetabu pengaruh - Kemampuan  guru  setelah
mengikuti pelatihan menggunakan program Microsoft Powerfoint.

Berikut ini disajikan gambar bagan rancangan percobaan, Gambar
4.1, merupakan rancangan percobaan dengan sasaran guru peserta pelatihan

penggunaan program Microsofi PowerPoint.

X
O1 —— Q2

KETRHANG AN

QO Tinall ¢ Heners moi Scbeluw Pelatiben
(1) 110t et gt Mol elutihen
h Y P Perlakuan bevups polutiliun

Pemgaruh polatiban=02- 0 1

Gambar 4.1. Bagan Penelitian Percobaan dengan Sasaran Guru

Sedangkan gambar 4.2., merupakan rancangan penelitian observasi
untuk mengetahui owmcome, dengan sasaran siswa yang menerima layanan
pembelajaran menggunakan media instruksional berbasis program Microsoft

PowerPoint.
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PBM
MENGGUNAKAN

MPrr

Co D Co D
PERHATIAN PERHATIAN
SISWA SISWA

KETERANGAN:
Qi Perlisdan Selelum PHN Moenggunakan MIP1*

O2  : Perhatian Setelah PBM Menggunakan MPP
Pengaruh PBM Menggunakan MPI* = 02 - O4

Gambar 4.2, Bagan Penelitian Observasi dengan Sasaran Siswa

4.2. Populasi, Sampel, Besar sampel, dan Teknik Pengambilan Sampel
4.2.1. Populasi

Penelitian ini akan meneliti dua populasi. Guru yang berjumlah
13 orang dan populasi siswa berjumlah 262 orang.

Populasi penelitian yang pertama, adalah guru SMP Kristen
Petra 5 Surabaya. Seluruh guru berjumlah 13 orang, terdiri dari guru
tetap 2 orang dan 11 orang guru tidak tetap. Guru Tetap adalah guru
yang kepadanya diberi tugas, tanggung jawab serta hak yang telah
ditetapkan oleh lembaga PPPK Petra. Guru Tetap selalu hadir setiap
hari. Sedang Guru Tidak Tetap adalah guru yang kepadanya diberi
tugas, tanggung jawab serta hak yang telah ditetapkan oleh lembaga
PPPK Petra dan tidak selalu hadir setiap hari. Kehadirannya sesuai

jadwal yang ditetapkan.
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Tabel 4.1. Data Populasi Guru SMP Kristen Petra 5 Surabaya
vang Belum Menguasai Penggunaan Microsoft

PowerPoint (MPP).
NO STATUS GURU JML
——— E
1 GURU TETAP 2
2 GURU TIDAK TETAP 11
JUMLAH 13

Sumber - Humas SMP Kristen Peira 5

Popuiasi penelitian yang kedua, adalah siswa kelas VIII SMP

Kristen Petra 5 Surabaya.

4.2.2 Sampel

Ada dua sasaran sampel yang diteliti. Pertama, sampel guru.
Sampel guru terdiri dari seluruh populasi guru tetap maupun guru

tidak tetap yang belum mampu menggunakan Microsoft PowerPoint.

Kedua, sampel siswa. Sampel siswa merupakan seluruh populasi
siswa kelas VIII. Meskipun dalam satu jenjang kelas jumlah siswanya
banyak, namun langkah ini dilakukan dengan mempertimbangkan

kemudahan dalam penghitungan statistik

4.2.3. Besar sampel
Penclitian imi menggunakan sampel guru berjumlah 13 orang
terdiri seluruh populasi guru tetap maupun guru tidak tetap yang
belum mampu menggunakan program Microsoft PowerPoint.
Selanjutnya, dan semua peserta pelatihan akan diambil 1

guru tetap atau guru tidak tetap yang paling mampu menggunakan
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program Microsofi  Powerloint untuk memberi layanan PBM di
kelas VI Sedangkan sampel siswa terdiri dari seluruh populasi

siswa kelas VIII yang berjumlah 262 siswa.

4.2.4. Teknik pengambilan sampel
Tahap pertama, sampel guru diambil dengan cara
menyertakan seluruh populasi guru tetap maupun guru tidak tetap
yang belum mampu menggunakan program AMicrosofi PowerPoint.
Tahap kedua, sampel guru yang berjumlah 1 orang
diperoleh dengan cara mengambil seorang guru bidang studi peserta
pelatthan dengan hasil nilai terbaik.
Sedangkan sampel siswa diperoleh dengan cara mengambil

seluruh populasi siswa kelas VIII yang berjumlah 262 siswa.

4.3. Vanabel Penelitian

Pada penelitian ini variabel independennya adalah kemampuan guru
sebelum guru diberi pelatihan menggunakan program  Microsoff
PowerPoint.  Kemampuan tersebut meliputi  kognitif, afektif, dan
psikomotor, Sedangkan variabel dependen yakni kemampuan guru sctelah
guru diberi pelatihan. Adapun variabel luar yang tidak diteliti diantaranya
adalah 1Q, EIl, SI, bakat, minat, pendidikan. Kedua variabel tersebut
diantarai oleh perlakuan berupa penyampaian modul, teori dan praktik

pembuatan media pembelajaran dengan menggunakan program Microsofi

PowerPoint,
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Variabel kemampuan dapat dirinci menjadi sub vartabel, ialu dirinci

lagi menjadi indikator. Vaniabel, sub variabel, dan indikator tersebut  dapat

dirangkum sebagai kisi-kisi penelitian seperti tampak pada tabel 4.2,

Indikator-indikator yang telah ditemukan sangat berguna sebagai bahan

dalam menyusun angket penelitian. Berikut ini disajikan kisi-kisi penelitian.

VARIABEL

Tabel 4.2, Kisi-Kisi Penchitian

SUB |
VARIABEL

INDIKATOR

PELATIHAN

1. Materi

_____peserla,

t. Kesesuaian dengan kebutuhan

. Kesesuaian dengan minat peserta.

2. Metode

2
1. Sesuai dengan tujuan yang
hendak dicapai.

. Berpusal pada peserta latihan.

3. Fasilitas

2
I. Memenuhi jumiah peserta.
2. Layak pakal.

4 Pelaksanaan |

i. Penjelasan.

2. Pemberian contoh,

o |w A
C

KEMAMPUAN

1.1. Pemahaman

i.1.1, Memahami perintah-peritah
dalam membuat presentas.

1.2. Analisis

1.2.1. Memilah masing-masing fung-
s1 elemen dalam pembuatan
presentasi

1.3. Sintesis

1. Pengetahuan

. digjarkan.

1.3.1. Menghubu-l_l_é-kii;i clemen
pembuatan presentasi dengan
maien bidang studi yang

1.4. Evaluasi

1.4.1, Menilai hasil akhir pembuatan
presentasi materi bidang studi.

TESIS
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2. Sikap

3. Ketrampilan

T

P 2.1 VALUING

dan responsibility.

2.1.1. Menerima nilai-nilai respect

2.1.2. Kesediaan menerapkan nilai-
nilaz.

2.2. ORGANIZATION

221 Menghankan mila-nslan lang
dengan nilai-nilai baru.

2.2.2. Mengatur dan menyusun nilai-
nilac lamac dan buru menjadi
satu kesatuan,

2.3. CHARACTERIZATION BY
VALUE OR VALUE COMPLEX

2.3.1. Menjadikan nilai-nilai lama
dan baru sebagai bagian dar
dirinya.

2.3.2. Menerapkan nilai-nilai lama
dan baru dalam membuat

_presentaS| matert _tyglang studi.
BASIC FUNDAMENTAL
MOVEMENTS

3.1.1. Menghentikan menombol tuts
keyboard secara refleks ketika

3.1.2. Menombol tuts keybourd
disertai melihat layar monitor.

3.2. PERCEPTUAL ABILITIES

. ada kesalahan mengetik. |

3.2.1. Menggunakan penginderaan
pendengaran (auditori).

| 3.2.2. Menggunakan penginderaan
| _ __g:nglihatan(vi_suul).

3.3. PHYSICAL ABILITIES

3.3.1. Keluwesan bekerja dalam
_membuat presentasi.

332 Ketangkasan dalam
_mengoperasikan komputer.

3.4. SKILLED MOVEMENT

3.4.1. Melakukan gerakan sederhana
yaitu mengetik.

17
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Vb2 Melahukao gerakan camipuran
! ! : (merangkum. mendesain '8
. presentasi, mengetik ).

- L1 Tulisan berwarna ’ l
1.2 Gambar berwarna o
LS Palisan dengan susunan tusbah _
. ]
I Objek batk .
° Lo DAk K
' 4. Gambar dengan susunan tambah
, batk
| - : -
1.5, Tulisan bergerak _j__*____J
| PERHATIAN L o 1.6 Gambarbergerak o
~2.1. Gemar melihat tlisan berwarna | 7
. UG miehehial gitmbag hclgu;lk A
. 2.3 Kebutuhan ilmu pengetahuan,. | 9
2 Subyek : ‘ pengetahu ‘ ‘
S Kebutuban rasa myan ahu o
2.8 Persiapan mengerjakan lugas. '_ '_ )
e . .. .26 Persiapan mengikuti wlangan. | 12|

Bahan Penelitian

Bahan penchitian adalah program Alicrosoft Powerlomr. Suatu
program perangkat lunak (Software) komputer vang berfungsi untuk
meningkatkan Kualitas tayangan suaty presentasi. Penelitian pada program
Microsofi Powerfoun ini dioptimalkan pada batasan penggunaan (fungsi
program) secara praktis. bukan pembuatan pada substans program perangkat

lunak (AT VT ou

Instrumen Penelitian
Instrumen yang  digunakan dalam penelittan melipun kuesioner,

dadtan peranyian observas, seria pedoman wawancara  Instrumen tersebul
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belum baku meskipun disusun berdasar pada kisi-kisi penelitian. Maka
instrumen tersebut perlu menjalani wji validitas dan reliabilitas agar dapat
memberikan data yang akurat. Pengujian instrumen dilakukan dengan cara
Focus Group Discus (FGD).

Penelitian  menggunakan instrument pendukung  berupa modul

‘pelatihan tentang program AMicrosofi  PowerPoin. Modul digunakan

responden selama kurun waktu mengikuti pelatihan.

Lokasi dan Waktu Penelitian

Penelitian dilaksanakan di SMP Kristen Petra 5 Surabaya.
Pertimbangannya bahwa di SMP Kristen Petra 5 Surabaya belum pernah
diadakan penelitian terhadap permasalahan serupa, serta lokasinya mudah
dijangkau. Adapun penelitian dilaksanakan pada semester genap tahun

pelajaran 2005/2006 serta memperhatikan jadwal kegiatan pembelajaran di

sekolah.

Prosedur Pengambilan Data

Sebelum  langkah pengambilan data dilakukan, kegiatan diawali
dengan mengajukan permohonan izin kepada kepala SMP Kristen Petra 5
Surabaya. Setelah mendapat izin penclitian, lfangkah selanjutnya adalah
memberni pretest kepada guru yang belum mampu menggunakan program
Microsoft  PowerPoint. Setelahnya memberikan pelatihan menggunakan
program Microsoft  PowerPoint. Pelatihan dilaksanakan dua kali pertemuan
di laboratorium komputer SMP Kristen Petra 5 Surabaya. Setiap pertemuan

disediakan wak(u 90 menit untuk penyampaian materi berupa teori dan
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prakich. Sctiap pelatiban, peserta didampings oleh dua tenaga instruktur yang
berasal dari penyelenggara pendidikan komputer Bangun Satya Wacana
(BSW) Wilayah Jawa Timur. Guru yang telah mendapatkan layanan pelatihan
penggunaan program Microsoft  PowerPoint diben kesempatan untuk
mendemontrasikan kemampuannya dalam penggunaan program Microsofi
PowerPoint pada Proses Belajar Mengajar (PBM) di kelas.

Pengambilan data dilakukan dengan menggunakan instrumen
observasi. Kegiatan observasi dilaksanakan secara berperan serta (Participant
Ohservarion). Pengambilan data secara observasi nonpartisipan dilaksanakan
ketika guru mendemontrasikan kemampuannya dalam penggunasn program
Microsot PowerPoms puda Proses Belujar Mengaga (PBM) di kelas,

Pengambilan data secara observasi nonpartisipan dilaksanakan
terhadap siswa sebelum dan setelah siswa menerima layanan pembelajaran
menggunakan program AMicrosofi  PowerPoint. Penggunaan instrumen
penelitian berupa kuesioner dan wawancara dilaksanakan setelah guru
mengthuts pelatthan program Arcrosapt PowerPomit Jun siswa selesat
mendapat layanan pembelajaran dengan menggunakan program Microsoft
PowerPoint.  Penyampaian instrumen kuesioner dilaksanakan dengan
memberikan langsung kepada responden serta menunggunya hingga
responden selesai menjawab seluruh pertanyaan dalam kuesioner tersebut.

Sasaran pengambilan data primer penelitian meliputi kepala sekolah.

instruktur, guru, siswa kelas VII. Sedang data sekunder diperoleh dari

dokumen di sekolah.
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4.8. Cara Pengolaban dan Analisis Data
4.8.1. Pengolahan data meliputi:
a. Pemeriksaan Data (Fditing)

Editing adalah proses untuk meneliti apakah jawaban yang
ada pada angket sudah sesuai dengan pertanyaan dalam
anghetnya. lawaban sesponden dulinm wawancaia detehits ulang
apakah sudah sesuai dengan item yang ditanyakan dalam daftar
wawancara. Demikian pula meneliti apakah hasil observasi telah
sesuai dengan item observasi.

b. Pembuatan Kode (Data Coding)

Data  coding  merupakan proses penyusunan secara
sistemabs data mentah (yang ada dalaim huesioner) ke dalaim
bentuk yang mudah dibaca oleh komputer.

¢. Pemindahan Data (Data Entering)

Data Intering adalah proses memindahkan data yang

telah diubah menjadi kode ke dalam komputer. Program
komputer yang  dipakan adalah Afrcrosoft foveel dan SPSS
(Statistical Package for Social Science).
d. Pembersih Data (Data (leaning)
Datu (leaning adalah proses untuk memastitkan bahwa
seluruh data yang dimasukkan ke komputer telah sesuai.
¢. Penyagian Data (Data Outpur)
Data Output merupakan hasil pengolahan data. Bentuknya

berupa angka dalam tabel dan charr.
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4.8.2. Analisis Data,

TESIS

Analisis data merupakan kegiatan  yang  meliputi
pengelompokan data berdasar varnabel dan jemis responden,
mentabulasi data berdasar variabel dari seluruh responden,
menyajikan data dari tiap variabel yang ditelii, melakukan
penghitungan untuk menjawab rumusan masalah, serta melakukan
penghitungan untuk menguji hipotesis yang diajukan. Besamya

hubungan antar variabel dicani dengan membandingkan.
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BARB S

ANALESES DAN HASIE PENEFEITTAN

3.1 Karaktenisuk Penchinan

Penchtian  dilaksanakan di SMP Knsten Petra 5 Surabaya
Pertimbangannya bahwa di SMP Kristen Petra § Surabaya belum pernah
diadakan penchiz werbadap permasalabian sernpa serta lokasinya mdah
dyangkau. Penelitian dilaksanakan pada semester genap tahun pelajaran
2005.2006 serta memperhatikan jadwal kegiatan pembelajaran di sekolah.

Kondisi lokasi penelitian dapat digambarkan sebagai berikut. SMP
Kristen Petra S Surabava merapakan salaly satu unit pendidikan dibawah
naungan Perbimpunan Pendidikan dan Pengajacan Knsten Petra (1PPPK
Petra) Surabaya. Vist yang dimiliki SMP Kristen Petra 5 Surabaya adalah
menjadi sekolah terbaik di [ndonesia Sedangkan 7 misinva vaitu; I
Melangkah berdasar Aikitab dan pengakuan iman rasuli; 2. Memberikan
pendidikan dan pengajaran terbaik; 3. Mengembangkan wawasan nasional
dan global; 4. Menciptakan komunikas: timbal balik dalam proses belajar
mengajar, 5. Menumbuhkan kesadaran Iingkungan dan ciptaan Tuhan; 6.
Membina kesetiakawanan yang positif dan mengasihi sesama: 7. Membina
kepribadian vang utuh dan dinamis. Untuk mencapai visi misi tersebut
maka diperlukan 4 kata operasional. anstara lun | [ atas rata-rata, 2
Target: 3. Berpikir dan bertindak 1uar biasa: 4. Terkait masa depan.

Seluruh guru berjumlah 47 orang, jumlah guru perempuan 26, guru

laki-laki 21, Usia guru rata-rata usia 40 th. Dari seluruh gury yang ada,
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vang berpendidihan diploma 2 orang (4.7%), peadidikan strata satu <4
orang (87.2%). dan vang berpendidikan strata dua 4 ovang (8.5%). Dan
segt status, ada 27 gurw tetap dan 20 gura tidak tetap.

Keadaan siswa digambarkan sebagar berikut. Jumlah keseluruhan
747 <tswa terdint dan kelas VI begpusnlaly 254 siswa, kelas VT berjumlah

262 Cserta kelas TH berjamlah 231 siswa.

3.2 Karaktenistik Responden.

Penelitian 11 menggunakan dua macam responden. Responden
guru dan responden siswa.

521 Responden Guru.
Guru yang yang belum bisa menggunakan program AMicrosoft
Powerpomt berjumlah 13 orang, terdint dan 2 guru tetap dan T guru
adak tetap. Namun suat pelatthan beelangsung vang tdak bisa
mengikuti adalah 3 guru udak tetap karena jadwal pelatihan
berbenturan dengan jadwal mengajar di sekolah lain. Maka pelatihan
menggunakan program Aficrosoft Powerponnt ditkuti oleh 10 guru
vang terdin dan guru bidang studi Olah Raga dan Kesebatan = |

orang, Bimbingan dan Konseling ~2 orang, Bahasa Indonesia 2

wlal, dent Kupa I otang, PPRn 2 otang, Geaglah I oy,
Bahasa Ingeris - | orang Jumlah guru wanita - 7. sedang yumlah
guru pna = 3 orang. Pelatthan dilaksanakan dua kab pertemuan yang
masing-masing  pertemuan  bertangsung 90 menit. Pelatihan

dilaksanakan scusal guru melaksanakan jam  pembelajaran  dan

llL'llL'llI[JlIl i lahocadoniam |u:|l||u||r|
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5.2.2 Responden Siswa.
Respondden siswa diambib dari sefuruh populast siswa kelas
VIII yang berjumlah 262 dengan rincian, jumlah siswa perempuan

FA7 i s fako-laka 125

5.3  Variabel yang Dibahas.
Variabel independennya adalah pelatihan penggunaan program
Microsofi PowerPomnt. Sedang variabel dependennya adalah kemampuan
guru  dulam  pembelagpan menggunakan  media anstruksional - berbasis

program Microsoft PowerPoint.

54 Metode yang Dipakai
Penelitian ini merupakan pra eksperimental, yaitu mencan
hubungan sebab akibat dari suatu gejala atau kejadian yang ada. Penelitian
mencani hubungan antara sebelum dan setelah pelatihan program Microsoft
PowerPoint bagi guru. Sedangkan penelitian observasi digunakan untuk
mengetahui pengaruh kemampuan guru terhadap perhatian siswa dalam

pembelajaran dengan menggunakan program Microsofi PowerPoint.

5.5 Data Penelitian
Dari proses pengambilan data, diperoleh data penelitian sebagai
berikut.
5.5.1. Data Skor Kemampuan Guru
Schelum  dan  setelah  pelatihan menggunakan  Microsoff

Powerpoint diperoleh data sebagai berikut:
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Tabel 5.1 Skor Kemampuan Guru Scebelum dan Setelah
Pelatihan Aicrosopt Powerpomnt
SEBELUM SETELAH
. . H 1 )‘ L Al
wo | KODE PELATIHAN I__lzLAIIHf:k_ljl i
- T GURU © KOG ' AFEK | PSIKO | KOG  AFEK i PSIKO '
Ll AMU UM ML LoAML o uML ML
| WR 9 13 - 16 | 18 22 - 27
2 J_EP 9 | 13 16 . 14 20 30
LS PT S 13 . 8 W 19 30|
S IN 9 9 16 18 R
g SZ_ | 7 i 11 ' 18 140200 28
6 HS 9 2 15 i 20 | 28
7 BT | 9 119 A5 20 o 31 |
) 8. SM 8 9% 16 i 15 18 | 28
9 EM 08 - 13 15 15 - 22 28
p 0 AP 9 17 1624 31
__JdMIL. ¢ 88 118 ° 166 147 204 : 289 °
Keterangan :
SBL  : Sebelum Pefatihan
ST - Setelah Pelatihan

Data di atas bila dirinci dalam dalam ¢ 7t adalah sebagai berikut:
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@ KOGNITIF é SEBELUM) : ;
B AFEKTIF B)E : :
O PSIKOMO O SE LUM
D KOGNITIF (SETELAH)

B AFEKTIF (SETELAH

® PSIKOMOTOR(SETELAH) |

Gambar 5.1 Skor Kemampuan Guru Sebelum
dan Setelah Pelatihan MPP

5.5.2 Data Skor Perhatian Siswa
Penelitian yang dilaksanakan saat sebelum dan setelah Proses
Belajar Mengajar (PBM) dengan menggunakan Microsoft Powerpoint,

menghasilkan data sebagai berikut:
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Tabel 5.2 Skor Perhatian Siswa Dalam PBM,
Sebelum dan Setelah Menggunakan Microsoft

lowerpomt

‘ URAIAN SKOR PERHATIAN DALAM PBM
NON MPP MPP SELISIH
TW 441 837 396
GW 458 863 405
| 1 ASPEK | TL 361 766 | 405
L OBJEK CGL | aso 848 398
. e Rk
. |GG 434 | 849 | 415
SKOR P 1358 2001 1306
ASPEK T~ | aog 1 ars sy
OB T e e
SW 420 800 380
SG 426 763 337
2. ASIPEK Bl 687 8§46 150
SUBJEK LT 745 839 | 94
' T 702 gag 1 146 |
) B TU 702 | 8s7 | 185
SKOR | P 1923 2505 642
ASPEK | L 1759 | 2388 629
_ SUBNK Tym 1 Jos 4y 1271
SKOR 1 p 1278 522 1948
TOTAL : L.:__.._____..__d___z_g?_.?_._.._ e _:1.’;'.63 . 1_ ._17}'86—
PERHATIAN
(Poin1+2) | ML 6255 9989 3734
Keterangan :
Jumlah Siswa Perempuan (17) 0 125 siswa

Jumtah Siswa [.aki-1aki (£y - 137 siswa
Jumlah Total Siswa Kls VUL ;202 stswa

Arli Kode sebagai berikut:

T™W : Tulisan berwarna
Gw - Gambar berwarna
TL - Tulisan tersusun secara lain dari biasanya
GL - Gambar tersusun secara lain dan biasanya

TG : Tulisan bergerak
GG : Gambar bergerak

SW  : Senang terhadap objek berwarna

SG : Senang terhadap objek bergerak

BI . Kebutuhan akan ilmu pengetahuan

IT : Kebutuhan rasa ingin tahu

TT : Kebutuhan tangpung jawab terhadap tugas

TU : Kebutuhan persiapan menghadapai ulangan
Non MPP : Tidak menggunakan Microsofi Powerpoint
MPP : Menggunakan Microsofi Powerpoint
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Data di atas dapat dibuat dalam beberapa Chart sebagai berikut:

PERHA_SBL FPERHA_STL
PERMATIAN

OPerempuan M Laki-laki

Keterangan:
PERHA_SBL : Perhatian dalam PBM sebelum menggunakan MPP
PERHA_STL : Perhatian dalam PBM setelah menggunakan MPP

Gambar 5.2 Skor Perhatian Siswa dalam PBM Sebelum
dan Setelah Menggunakan MPP.

| SKOR
OBJEK_SBL OBJEK STL  SUBJEK_SAL  SUBJEK STL
ASPEK PERHATIAN
i B Perempuan G Laki-laki |
Keterangan:

OBJEK_SBL : Objek perhatian dalam PBM sebelum menggunakan MPP
OBJEK_STL : Objek perhatian dalam PBM setelah menggunakan MPP
SUBJEK_SBL : Subjek perhatian dalam PBM sebelum menggunakan MPP
SUBJEK_STL : Subjek perhatian dalam PBM setelah menggunakan MPP

Gambar 5.3 Skor Dua Aspek Perhatian Siswa dalam PBM
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1TW 2GW ITL 4GL 5TG 6GG 75W A5G %81 10/ 11TT 12TU ‘
ASPEK PERHATIAN

W SEBELUM DENGAN MPP T SETELAH DENGAN MPP

Gambar 5.4 Skor Seluruh Aspek Perhatian Siswa dalam PBM
Sebelum dan Setelah Mengggunakan MPP

1000
800
skor 600
400
200 ;

1TTW2GW 3TL 4GL 5TG 6GG
ASPEK OBJEK PERHATIAN

B NONMPP  mMPP

Gambar 5.5 Skor Aspek Objek Perhatian pada PBM
dengan Non MPP dan PBM dengan MPP

SKOR

18W 2S8G 3Bl 4IT 5TT 67U
ASPEK SUBJEX PERHATIAN

® NONMPP % wmPP !

Gambar 5.6 Skor Aspek Subjek Perhatian pada PBM
dengan Non MPP dan PBM dengan MPP
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5.6, Analisis dan [nterpretas:

Data peneliian vang diperoleh selanjutnva diolah dan dianalisis.
Pengolahan data penelitian dilakukan dengan menggunakan program
Microsoft txeel dan program  SPSS (Statistical Product and  Serviee
Sedutronsy verse 1400 Analisis terhadap hasil pengolahan data dilakukan
‘dengan memperhatikan Dasar Pengambilan Keputusan (DPK) serta mengacu
pada 2 (dua) hipotesis penchitian,

Hipotesis  pertama, pelatthan  penggunaan  program  AMficrosoft
PowerPoimnt mempengaruhi kemampuan batk kognitif, afekuf, maupun
psikomotorik  guru dalam proses pembelajaran. Jika diturunkan dalam
hipotesis statistik menjadi:

I Pelatthan penggunaan program Aficrosoft Powerl oms mempengaruly
kemampuan baik kognitit, atektif, maupun psikomotorik guru dalam
proses pembelajaran.

Hipotesis kedua, penggunaan program Microsoft PowerPoint dalam
proses pembelajaran mempengaruhi perhatian siswa. Jika diturunkan dalam
hipotesis statistik menjadr.

Hy  Penggunaan program Afrcrosoft Powerlomit dalam proscs
pembelajaran mempengarvhi perhatian siswa,

Adapun dasar pengambilan keputusan mehputi:
a. Pengupian dengan dua sisi (¢wo taifed rest).
b. Tingkat sigmifikanst adalah (a) - 0,05,
¢. Nilai Probabhilitas:

¢ Jika probabilitas - 0,05, Ho ditolak.
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¢ Jika probabtlitas - 0,05, Ho diterima.

Berikut pengolahan data penelitian tentang kemampuan guru dalam

menggunakan program Aficrasoft PowerPomt beserta analisisnya

5.6.1 Kemampuan Guru
" 56.1.1. Kognitif Guru
Sebelum  pelatihan, kognitit guru rata-rata 8,50, Setelah
pelatthan, guru memiliki kognitif rata-rata 14.70.
Berdasarkan pada nilai probabilitas yang - 0,05, maka [Ho
ditolak. Kesimpulannya bahwa pelatihan efektif mempengaruhi

kognitf guru.

5012 Alekul Guru
Sebelum pelatihan, afektf gure rata-rata 11,80 Setelah
pelatihan, gure memiliki afektif rata-rata 20.40.
Berdasarkan pada nilai probabilitas yang < 0,05, maka Ho
ditolak. Kesimpulannya bahwa pelatihan efektif mempengaruhi

alektit prury

5613 Psikomotonk Guru
sebelum  pelatihan, pstkomotonik guru rata-rata 16,60,
Setelah petatihan, guru memiliki psikomotorik rata-rata 28,90,
Berdasarkan pada nilai probabilitas vang ~ 0.05, maka Ho
ditolak. Kesimpuiannya bahwa pelatthan elekuf mempengarabi

psikomaotorik guru.
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Berikutnya adalah pengolahan data penclitian wentang perhatian
siswa dalam PBM menggunakan program Aficrosofi PowerPoint beserta

anahsisnya.

56.2. Perhatian Siswa

5.6.2.1

Seperti pada pengolahan data kemampuan guru, pengolahan data
tentang perhatian siswa dilakukan dengan menggunakan program
Microsoft Fxcel dan program SPSS versi 14.0. Hasil pengolahan dengan
menggunakan program Aficrosoft fxcel tampak bahwa t hitung - -127.03
ditentukan oleh kegiatan PBM dengan menggunakan MPP. Masih
dimungkinkan dagi  bila guru mau menyajikan materi  dengan
mengoptimalkan sound effect vang ada dalam program  Microsofi
PowerPomi tersebut,

Selanjutnya data tentang perhatian vang diolah meliputi aspek

objek perhatian dan subjek perhatian siswa.

Perhatian Siswa Sebelum dan Setelah PBM Menggunakan Program MPP.
Sebelum PBM menggunakan MPP perhatian siswa rata-rata 23.9.

Setelah PBM menggunakan MPP perhatian siswa rata-rata 38,1
Berdasarkan pada nilai probabilitas yang < 0,05, maka Ho ditolak.

Kesimpulannya bahwa PBM dengan MPP efektif mempengaruhi perhatian

51SWa.

5.6.2.2 Penilaian Siswa terhadap Aspek Perhatian.

Hasil Penidaian Siswa terhadap Aspek Perhatian (Versi ['ricdman

fest) sebagar berikut.
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H,  Salah satu dart empat aspek objeh perhatian mendapat penilaian
lebih dar siswa
Berdasarkan pada nilai probabilitas = 0,05 maka o diolak.
Kesimpulannya bahwa salah satu dan empat aspek objek perhatian

mendapat penifaian lebih dan siswa.

5.6.2.2 1. Penilaian Siswa terhadap Empat Aspek Subjek Perhatian.

Hh Sadade sata dans engpat aspek subyek perhatinn omendapat penbscan
lebih dan siswa.
Berdasarkan pada nilai probabilitas - 0,03, maka Ho diterima,
Kesimpulannya bahwa keempat aspek subjek perhatian mendapat

penilaian vang sama dari siswa.

30,222 Husil Kesepubatan Siswa erhadap Aspek Perhatian cverst Avadat! s 1

fost)

Hi - Ada keselarasan kesepakatan di antara responden menila
kedelapan aspek perhatian.
Berdasarkan pada nilai probabilitas - 0,05, maka i lo ditolak.
Kesimpulannya bahwa ada keselarasans kesepakatan di antara

responden dalam mienilai kedelapan aspek perhatian
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PEMBAHASAN

6.1 Gambaran Umum Sebelum Penelitian
Ketika SMP Kristen Petra $ belum mengoptimalkan pembelajaran
" secara multimodal, maka muncul berbagai pertayaan. Diantaranya adalah,

perlukah diadakan pelatihan untuk peningkatan kemampuoan guru”? Kalau
benar perlu diadakan pelatihan, adakah pengaruh berupa owput terhadap
pemngkatan kemampuan guru? Pertanyaan selanjutnya adalah bila guru telah
meningkat kemampuannya, apakah ada pengaruh berupa omcome  terhadap
peserta didiknya”

Dari pertanyaan tersebut akhirnya terpilih dua rumusan masalah
penelitian. Pertama. Apakah pelatihan penggunaan program Aficrosofi
PowerPoint dapat mempengaruhi kemampuan baik kognitif, afektif, maupun
psikomotorik guru dalam proses pembelajaran”? Kedua. Apakah penggunaan
program  Aficrosoft  PowerPoint dalam proses pembelajaran dapat
mempengaruhi perhatian siswa?

Maka tujuan penelitian ditetapkan yaitu untuk menganalisis pengaruh
pelanhan penggunaan program Microsoft PowerPomnt terhadap kemampuan
guru dalam meningkatkan perhatian siswa kelas VIl SMP Kristen Petra S
Surabaya.

Berdasar teori yang ada maka disusunlah pula dua hipotesis. Pertama,
bahwa pelatihan penggunaan program Microsoft  PowerPont  dapat

mempenganuln hemampuan bk kogoul, afchal, maupun psihontototik gury
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dalam proses pembelajaran. Kedua, penggunaan  program  Aficrosofr
PowerPoint dalam pembelajaran dapat mempengaruhi perhatian siswa.

Teorn yanp dimaksud dan vang terkait dengan kemampuan giuru
adatah pendapat  Bloom, yang menyatakan bahwa cara  individu

mengungkapkan hasil pembelajaran berada  dalam kawasan  kognitif,

© afektif, dan psikomotor. Sedangkan Gagne, menyatakan bahwa setidaknya

ada lima macam perubahan perilaku akibat pengalaman vakni: I. Belajar
responden, 2. Belajar kontiguitas, 3. Belajar operant, 4. Belajar
observasional, dan 5. Belajar kognitif. Demikian pula Robert I.. Mathis dan
John 1L Jackson. menvatakan bahwa pelatiban kerju-ketrampitan (yob-skiff
traming) adalah bagian dari pelatihan dan pengembangan Sumber Dava
Manusia (SDM).

Sedangkan teori vang terkait dengan perhatian siswa adalah pendapat
Suryabrata. Dia menyatakan bahwa yang menarik perhatian adalah hal yang
keluar dari konteksnya atau dengan kata lain. hal vang menarik adalah hal
yang lain dari pada yang lain. Hal lain tersebut bisa timbul dari warna,
gerakan, susunan, serta kebiasaan. Selain objek, Suryabrata juga menyatakan
bahwa hal vang menarik adalah hal yang sangat bersangkut paut dengan

pribadi subjek. Misalnya: kebutuhan, kegemaran, pekerjaan atau keahlian.

Metode Penelitian

Penelitian yang memerlukan dua kelompok responden yaitu guru dan
siswa ini menggunakan metode pra eksperimental dan observasi. Pada
penelitian pra cksperimental, variabel independen yang digunakan berupa

pelatihan penggunaan program Microsofi PowerPoint. Variabel dependennya
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adalah kemampuan guru. Sedangkan pada penelitian observasi, variabel
Independennya vaitu perhatian siswa dalam PBM sebelum menggunakan
MPP. Variabel dependennva vyaitu perhatian siswa dalam PRM setelah

menggunakan MPP,

- Analisis Hasil Penelitian dan Interpretasi

Berkaitan dengan hipotesis penelitian. maka data vang dikumputkan
untuk kegiatan penelitian ternyata mendukung kedua hipotesis penelitian,
Hipotesis yang pertama telah terbukti, bahwa pelatihan penggunaan program
Microsofi PowerPomt mempengaruhi kemampuan baik kognitif, afektif,
maupun pstkomotorik guru. Terbukti t hitung setrap aspek secara berurutan
adalah: kognitif = -127.03; afektit = -153,70; psikomotorik  -343 .91

Hipotesis vang kedua, yaitu penggunaan program  Microsoft
PowerPoint dalam proses pembelajaran mempengaruhi perhatian siswa. Pada
t hitung diperoleh angka -14,52. Peningkatan perhatian siswa terhadap PBM
dengan menggunakan MPP cukup berarti. Perhatian siswa yang lerbesar
terfokus pada aspek objek perhatian berupa tulisan yang bergerak, diikuti
secara berturut-turut aspek objek perhatian gambar berwarna, gambar
bergerak, dan tulisan berwarna. Aspek subjek perhatian yang terdapat dalam
diri siswa yang meliputi: senang terhadap warna, senang terhadap gambar,
kebutuhan ilmu pengetahuan  dan  kebutuhan bertanggung  jawab
menyelesaikan tugas-tugas mendapat perhatian dan penilaian dari siswa,
Artinya bahwa siswa memberi perhatian serta penilaian vang  sama

terhadap masing-masing  aspek  subjek perhatian yang ada dalam dirinya,
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Tidak ada perhatian yang lebih menonjol terhadap salah satu aspek subjek
perhattan yang lain. Dan mereka sepakat dalam menilai seluruh aspek
perhatian yang adu.

Dengan demikian dari hasil pengolahan data serta analisis penelitian

menunjukkan bahwa pertama, pelatihan penggunaan program Microsoft

Powerl’owmr dapat mempengaruhi kemampuan baik kognitif, afektit, maupun

pstkomotorik guru dalam proses pembelajaran. Kedua, penggunaan program
Microsoft PowerPoint dalam proses pembelajaran dapat mempengaruhi
perhatian siswa. Bila hasil penelitian dihubungkan dengan teori, maka hal itu

merupakan bukti dukungan terhadap teori yang dipakat dalam penelitian ini.

Keterbatasan Penelitian

Penehiian ini memiliki sepi keterbatasan. Keterbatasan penchittan
yang pertama, adalah tidak adanya kelompok kontrol. Kedua, waktu yang
tersedia untuk pelatihan hanya dua kali pertemuan, sehingga dimungkinkan
kurang optimalnya guru dalam persiapan PBM menggunakan program
Microsoft PowerPomt. Ketiga, terlalu pendeknya waktu antara setelah gury
selesai pelatihan dengan jadwal harus segera presentasi hasil pelatihan dalam
PBM di kelas, sehingga dimungkinkan presentasi yang disajikan kurang
optimal. Maka, bagi peneliti lain yang berminat terhadap objek penelitian ini

atau yang serupa, hal ini merupakan peluang yang menantang untuk diteliti.
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PENUTUP

7.1. Kesimpulan
Dari hasil kegiatan penelitian, maka berikut ini disajikan berapa hal
_sebagai kesimpulan.
7.1.1. Rumusan Masalah
¢ Dua rumusan masalah penelitian telah terjawab. Pertama, bahwa
pelathan  penggunaan program Microsoft  PowerPoint  dapat
mempengaruhi kemampuan guru. Kedua, penggunaan program
Microsoft  PowerPoint dalam  proses  pembelajaran dapat
mempengaruhi perhatian siswa kelas VIII.
7.1.2. Hal Perhatian.
o Objek perhatian yang disajikan melalui media pembelajaran
Microsoft PowerPoint mendapat perhatian secara nyata dari siswa.
Siswa memberi perhatian secara iebih baik terhadap masing-
masing aspek objek perhatian.
* Subjek perhatian yang terdapat dalam diri siswa, mendapat
perhatian dan penilaian dari siswa. Siswa memberi perhatian dan
penilaian secara sama terhadap masing-masing aspek subjek

perhatian.

7.2. Saran

7.2.1. Mantaat yang Diperoleh
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Berikut disajikan beberapa manfaat yang bisa diperoieh dalum

penehtian serta saran membangun bagi pi hak yang terkait.

TESIS

Keberhasilan pelatihan dalam  mempengaruhi  peningkatan
kemampuan guru ditunjukkan dengan hasil t hitung pada masing-
masing aspek kemampuan sebagai berikut: a. Kognitif = -127.03 -
b. Afektif = -153.70: ¢. Psikomotorik =-343 91

Ada peningkatan perhatian dari siswa dengan t hitung - - (4,25
Hasil peneliian menyarankan bahwa selain guru harus terus

meningkatkan kemampuannya secara individu, maka pihak sekolah

Juga perlu menindaklanjuti dengan memberi kesempatan kepada

guru untuk melatth din dengan maten vang telah diperoleh,
sehingga perhatian siswa diharapkan dapat lebih meningkat,
Setelah itu barulah guru diberi materi pelatihan tingkat lanjut. Jika
tahapannya tidak demikian maka akan terjadi banyak kerugian.
Kerugian tersebut antara lain: tidak adanya peningkatan perhatian
oleh siswa, dimungkinkan justru siswa akan mengalam:
demotivasi, guru menjadi tidak optimal datam mengaktualisasikan
kemampuannyva, pihak sckolah maupun pihak PPPK Petra akan
mengalami kerugian dari <egi capaian pembelajaran dan dana.

Penentuan tingkat kecepatan pada objek bergerak, baik tulisan
bergerak atau gambar bereerak, sebaiknva proporsional Pada level
gerak paling lambat. akan mengakibatkan perasaan jenuh pemirsa
(siswa) dalam menunggn  atas informasi yang akan disampaikan.

serta pemborosan wakic belajar. Namun pada level gerak vang
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terlaiu cepat. menimbulkan perasaan tides nyaman karena ada
keterkejutan.  Lama tayangan hendaknva juga proporsional.
Tayangan yang terlalu lama, menimbulkan perasaan bosan,
Karena tidak menimbuikan motivasi pemir-a (siswa) untuk segera
menuntaskan nformasi yang disajikan. \amun tayangan vang
terlalz cepat bergantt, dapat menimbulkan ~erasaan putus asa.
karena pemirsa (siswa) merasa tertingga’ atas informasi vang
dibutuhkannva

e Penguunaan MPP harus mempertimbanzkan minat individu
terhadap warna beserta intensitas yang menyertai pada setiap
warnznya. Dalam mendesain tavangan herdaknya menggunakan
prins:p dan aturan dalam mengkomposisi wzrna, sehingga hasilma
nyvamazn diliha:

* Apab:ia ada dzta dani pthak Usaha Kesehatzn Sekolah (UKS) yang
men)atakan bahwa ada siswa yang buta vwima, maka hendaknva
guru membenkan penjelasan tamnahan kenada siswa vang buta
warnz tersebut Hal demikian pentng dilakikan demi peningkatan
minai belajar siswa seria efektnitas pe-vampaian materi 1t

sendim

Berihot  beberapa  kelemahan :ang  peciu menjadi bahan
pertimbar zan uniik penvempurnaan pada wasiu-waktu mendatany.
Khususny: bagt ocenehiti fain vang hermine: dalam  pelaksanaan

penelitiar sejenis
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¢ Penchtian im udak menggunakan kelompok kontrol.
¢ Waktu yang tersedia untuk pelatihan hanya dua kali pertemuan,
» Terlalu pendeknya waktu antara setelah guru selesai pelatihan

dengan jadwal harus segera presentasi hasil pelatihan dalam PBM.

7.2.3. Penclitian Lanjutan
Dengan adanya keterbatasan dan kelemahan dalam penelitian
im, maka peluang yang juga merupakan tantangan masih terbuka luas
bagi peneliti lain yang berminat mendalami seputar permasalahan yang

sangat menarik in.
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MEMBUAT SLIDE PEMBELAJARAN
MENGGUNAKAN
MICROSOFT POWERPOINT

A. PENDAHULUAN

Microsaft “owerPoint  adalah program yang dirancang untuk
menyiapkan presentasi. Presentasi baik dalam seminar, lokakarya maupun
proses belajar mengajar.

Program imi dapat memvisualisasikan data maupun gagasan secara
menarik dengan menggunakan fasilitas efek tampilan. Huruf, gambar animasi,
dan folo merupakan objek yang dapat didesain hingga menghasilkan media
presentasi berupa s/ide yang sangat menarik. Bahkan Microsoft PowerPoint
menyediakan sarana pendukung suara iaudio) intuk memberikan effect dan
ilustrasi saat sfide ditayangkan.

Modul ini memuat beberapa pedoman vang perlu diperhatikan dalam
pembuatan sfide dengan Microsofi PowerPoin: Hal ini agar sesuai dengan
tujuan pembuatan program Microsoft PowerPoir: u sendiri.

Sistematika modul int terdiri atas: teori pembuatan slide dengan
Microsott Powerl’ :nt, praktek membuat slide dengan Microsofi PowerfPoint,
dan penugasan. Penugasan merupakan kegiatan pembuatan siide AMicrosofi

Powerl’oint umtuk sctiap guru sesuai bidang studi vang diajarkan,

B. TEOQORI PEMBUATAN SLIDE DENGAN MICROSOFT POWERPOINT
Tujuan utamz pengadaan fasilitas AMicrofi PowerPoint adalah untuk

menampilkan tayangan presentas: berupa (s/ide) vang menarik, sederhana, dan
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mudat dipahami pemirsa (siswa). Mak: beberapa hal yang perlu dipzrhatikan

antara ain:

I

to

_L.\)

A

Gunakan gambar animasi, ka-katur. dan foto vang sesua: sebagai
ilustrasi pendukung data.

Gunakan komposisi wama -:cara proporsional Tayang:n slude
terkesan sejuk bila secara prioorsional jumlah puel warra-warna
‘dingin” (ungu, ungu kebiru-b.-:an, bire. biru kehyau-hijauzs. hijau,
hijau kekuning-kuningan) lebit sanyak daripada jumiah pixc wama-
wama ‘panas’ (kuning, kunin: keorange-orangean, orange orange
kemerah-merahan, merak, mere- keungu-unguan).

Gunakan unsur gerak. Tulisz: dan gambar bergerak paia awal
penayangan siide lebih menarii perhatian pemirsa. Aturlah z.ar slide
muncul  dengan gerakan .ang  variatif Caranya dengan
mengkombinasikan antara kecesatan dan ragam gerakan.

Optimalkan fungsi suara ya-: tersedia. Perlu pengaturzn pada
volume suara agar tidak m:sdominasi pembicara yang sedang
menjelaskan. Pemirsa (siswa) z.an lebih nyaman saat mend:cagarkan
penjelasan pembicara ketika rusik mengalun dengan sayLo-sayup
terdengar. Musik instrumental :.iran klasik lebih disarankar sebagai
pendukung saat s/ide ditayangh:s

Latar belakang yang dominan -usainva warna lebth cerah. Tustrasi
lebih ramai ), akan menggangge sbjek dr depannva Seharusn-a objek

vang di depan mendapat perhat :1 penuh.
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6. Menggunakan kata, kalimat, dan iiusirasi sederhana agar pemirsa
cepat memahami 1s1 pesan yang ditayangkan.

Bila siide Microsofi PowerPoint telah selesai dibuat, maka untuk

menayangkannya perlu bantuan berupa LCD (Liquid Crystal Display).

Melatui LCD 1ni, shde ditayangkan dalam format besar sehingga pemirsa

dalam sebuah kelompok dapat melihatnya secara jelas.

C. PRAKTEK MEMBUAT SLIDE DENGAN MICROSOFT POWERPOINT
Berikut langkah-langkah dalam pembuatan slide dengan menggunakan
program Microsoft PowerPoint:

1. Aktifkan Power Poinr. Pilih Blank Presentation.

2. Pilih menu /-ile, Page Setup. Perhatikan kotak dialog Page Setup. Program

secara otomatis men-sefup pada tahap awal.
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4. Akufkan Insert Picture. Pilihlah foto Harer hlies jpg. Copy foto
tersebut dan klik paste pada bagian ¢ Vick 1o Add Subtitle.

5. Klik /nsert lalu klik new siide. Sekarang memiliki slide kosong vang baru.
Ketik: MATA PELAJARAN. Klik Jnsert Worddrr. Klik pilihan kolom
pertama baris satu. Ketik: BUDI PEKERTI  Ketik: NAMA GURU, Dirs.
Eddy Purwanto inama diisi sesuai nama guru masing-mastng) pada ( lick to
Add Subtitle.

6. Ulangi langkah 5. Klik /nsert WordAre. Pilih tpe huruf pada kolom empat
baris tiga. Ketik: 3 COMPONENTS GOOD CHARACTER pada (lick to
Add Title.

7. Ulangi langkah 5. Ketik 3 COMPONENTS GOOD CHARACTER pada
Click 10 Add Tule. Klik oval, Buatlah bidang elips. Klik Add Text, lalu
ketik: MORAL KNOWING. Cara vang sama untuk MORAL FEELING,
dan MORAL ACTION. Klik AutoShapes, kiik connectors. Atur agar ada
hubungan.

8 Ulangi langkah S Ketik: MORAL KNOWING pada Click 1o Add Title.
Ketik  Tahu nilai-nilai moral, Tahu alas an moral, Tahu manfaat moral
pada (fick ro 4dd Subinle. Kiik Inserr Clip Are. Pilih gambar yang sesuai.
Copy dan pusie.

9. Ulangi langkah 5 untuk MORAL FEELING dan MORAL ACTION.

10.  Ulangi langkah 5 Ketik: IT’S NOT HARD TO MAKE DECISIONS
WHEN YOU KNOW WHAT YOUR VALUES ARE (Roy Disnev) pada

Click 10 Add Subnile. Blok Roy Disney. lalu khik Fomnr Color. Pilih warna

Kuning.
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1. Ulamg: angkah 5. Ketiklah' TERIMA KASIH, SELAMAT BELAJAR,
SUKSES UNTUK ANDA di bagian ( Tick 10 Add Subritle. Aktifkan Inserr
Piczurc Pilthlah foto Sunset jpg. Copvlah foto tersebut dan klik paste pada

bagnan Vick to Add Subiitle.

D. PENUGASAN
. Buzlah Kerangka Slhide dari bidang studi yang Anda ajarkan dengar.
sus_nan: pembukaan, 1s1. dan penutup.
2. Bulah [ (satu) Kerangka Konsep (Peta Konsep) dari pokok bahasan
van: Anda ajarkan di semester ini dalam slide menggunakan program

Micosoft PowerPoint.
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Lampiran Lembar Kerja:

LEMBAR KERJA
MEMBUAT SLIDE PEMBELAJARAN

MENGGUNAKAN PROGRAM MICROSOFT POWERPOINT
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Lembar Kerja Membuat Siide Pembelajara-
Menggunakan Microsoft PowerPoint

SELAMAT DATANG

MATA PELAJARAN :

BUDNREKERTI

NAMA GURU :

Drs. Eddv Purwanto

3 COMCOMTEITS

ChAG a0

66
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Lampiran: IR

Lemba- Kerja Membuat Slide Pembelajaran
Menggunakan Microsoft PowerPoint

3 COMPONENT

GOOD CHARACTER

@

MORAL ACTION /

MORAL KNOWING

® Tahu nilai-nilai moral

==

a Tahu alasan moral 3

® Tahu manfaat moral @

MORAL FEELING

s EMPATI

= KESADARAN DIRI 3

s PENGHARGAAN DIRI )

67
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Lampiran:

Lembar Kerja Membuat Slide Pembelajaran
Menggunakan Microsoft PowerPoint

MORAL ACTION

' mKompetensi

sKemauan

- mKebiasaan

#

IT'S NOT HARD
TO MAKE DECISIONS

WHEN YOU KNOW WHAT

YOUR VALUES ARE

(Roy Disney)

TERIMA KASIH

SELAMAT BELAJAR

~ SUKSES UNTUK ANDA

68
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NAMA GURU e
BIDANG STUDI e
NILAL
PRETEST / POSTTEST*
MATERI t MICROSOFT POWERPOINT
WAKTU : 20 MENIT
Petunjuk mengerjakan:

Bapak/ Ibu dipersilakan memiiih jawaban yang menurut Bapak/ Ibu paling
benar dengan melingkari huruf di depan alternatif jawaban.

Quick Launch

™o =

1 2 3 4 3

1. Dari kehima gambar icon di atas, pilihiah gambar icon nomor berapa yang
sebagai icon Microsofi Power Point

oo oP
Lh b L b e

Anal _— nzn@: ix A = (3 Dagon
¢ waﬁw' LA W -

C,Ib:klnxkimm

Mmoo

[ am ¥ HMoet = =Y .

[B] sioshopns- ~ ~ IO A D EDE S-JA-==
hde 1 of 1 [ gty {U.5.) [+ o

2. Agar muncul tayangan seperti di atas, maka perintah yang digunakan ...
Microsoft Power Point > Program > Start
Start > Microsoft Power Point > Program
Microsoft Power Point > Start > Program
Start > Program > Microsoft Power Point
Program > Start > Microsoft Power Point

c A o
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3. Agar muncul pilihan slide di sebelah kanan pada gambar d1 atas, maka
perintah yang digunakan ...

Fiew > Master > Slide Master

Fiew > Slide Master > Master

Slide Master > Master > Fiew

Slide Master > Fiew > Master

Master > Fiew > Slide Master

o a0 oD

w::v;‘{lﬂm—.. AT D LD Wik ferem st Ry . G am T T TN ‘
- a;:i-n-.:i.a - - Lo |
L Lapaiak 17 |
?
4. Untuk menambah slide baru, maka perintah yang digunakan ... |
a. New Slide Master > Insert
b. New Slide Master
¢. Insert
d. Insert > New Slide Master
e. Insert < New Slide Master
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5. Agar muncul pilihan gambar/ foto yang tersimpan di file komputer
(tampak icon file di atas), maka perintah yang digunakan ...

From File > Insert > Picture

From File > Picture > Insert

Picture > From File > Insert

Insert > From File > Picture

Insert > Picture > From File

o R0 o

weod Al Loallery S : “".ﬂ.’.‘.ﬂ
Select a WordArt styie:
[T W
WMI,M weraae [Worahet Woraat|
—é | 4
vigegd.st [Word At PHardiet [0 (Wenilt ] 2

[~ . - Y
A w wardan | Worr Art i oy

[ﬁﬂn Wi GAN IM Nl |0 : w
Lo §_ cnu |

6. Agar muncul pilithan huruf di atas, maka perintah yang digunakan ...
Insert > WordArt > Picture

[nsert > Picture > WordAnt

WordArt > Picture > From File

Picture > WordArt > Insert

WordArt > Insert > Picture

O RO o
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agran HGallery

Select a diagram type:

0

S 7 ||| Sk
o o’ 1N

COrganization Chart
Usad to show hlerarchical rejationships

I

®
©

| ok | cancel |

7. Agar muncul pilihan diagram di atas, maka perintah yang digunakan ...
Insent

Diagram

Insert > Diagram

Diagram > [nsert

Insert < Diagram

Diagram > [nsert > Art

e QO oR

B AvantGarde Bk BT Bald Ttk a
T AvantGarde Md BT = 2
~Effacts + Colars
T undedine I superserip | [r——— ]
T shadow offset:]0 % ‘
. I™ Emboss I subsoipt | ¥ Dorad For pew chyeme
This is a TruaType font.
This same font will ba used on bath your printer ard your scraen.
8. Agar muncul ptithan jenis huruf di atas, maka perintah yang digunakan ...
a. Font
b. Format
¢. Font > Format
d. Format> Font
e. Format > Font > Set
Preteste®tasttest Guru PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO |
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By arel S ks i i g
1 1) I
Mone 2 2 I
3 3 m
a) s a. - I

5 b L I
[ ) c) T [ . .
Yty RO S T |
allil [T b coc |

9. Agar muncul piliban jenis nomor depan, maka perintah yang digunakan ...
Format

Bullets and Numbenng

Format > Bullets and Numbering

Bullets and Numbering > Format

Format > Numbering

oo o

Chich to add tithe

Thak Ak

L L adlen

[ LI l

(Gl . W A A S MR, WA, By o,
-1 iakaan )

el gpANEND 000 . -
Jwmrren [ yamn st v {HEr - e

10. Agar muncul pilihan jenis desain, maka perintah yang digunakan ...

Format
Slide Design
Format > Slide Design

Slide Design > Format
Format > Design

oan op
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ﬂsn-.—m—m‘n—n—un
.o HEE L EE IR = R R
wa vtvli}..st...‘a"galh- e,

Chek to add thle

PUIORC S HERT S LR

o €T

E- LA -

e[t TTTHAT IR ML AE B T e S mEE S oL
[ SYLE [T Y i

#3d G ADIDEA . -
gwmn: | Wjame et vt | el Preatu - H e

11. Agar muncul pthhan jenis layout (pengaturan tulisan dan gambar), maka

perintah yang digunakan ...
a. Format

b. Slide Lavout

¢. Format > Slide Lavout
d. Slide Layout > Format
€. Format > Layout

i'l@w-r--—lrrtv-#—r—h
o Toraby @ A [ 1o RPN R ]
s .....;.:ijwi:' : ;

FELATIHAN

ORIEMTAS|
PRAKTRUM
ErALUAS|

s =t = _'I
Iﬁvﬁ LT
om[l] s - W AD PR NLAMTER W P BE R Y g
- sl gy LT ]
fae] QNP EEREY 2 B
e [T ] o

12. Agar muncul pilihan warna desain, maka perintah yang digunakan ...
Slide Design

Color Scemes

Format > Shde Design > Color Scemes

Color Scemes > Slide Design

Design > Color

coae o
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PELATIHAN

+ PENGANTAR

« PENYAJIAN TEORI

+ PRAKTIKUM
ALUASI

Ay
Y man
Lo
-

S

-

2.

13. Agar tayangan slide show di atas kembali normal, maka perintahnva ...

15.

16.

o /o oW

End Show

The End

Finish

Close

Program > Finish

. Microsoft Power Point adalah program komputer yang secara khusus

disiapkan untuk keperluan...

o ac o

menambah halaman pengetikan dengan gambar
pembuatan tayangan animasi

presentasi

pengolah data penulisan

penambahan citra tampilan

Microsoft Power PPoint dapat menamptilkan objek berikut ini secara lebth
menarik, kecuali objek berupa ...

o0 oR

gambar
suara
huruf
patung
foto

Tayangan Microsoft Power Point akan lebih menarik jika secara
proporsional menyertakan unsur pendukung yang biasanya disebut ...

o RS o

1lusi
tlustrasi
transposisi
kisi-kisi
komposisi

Prefestefasitest Guru PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO
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17. Jika kita menghendaki agar tayangan tampil bagus dengan nuansa dingin
(sejuk), maka ...

wama biru lebih banyak daripada warna orange

warna biru sama banyaknya dengan warna orange

warna biru lebih sedikit daripada wama orange

warna htjau Iebih sedikit daripada wamna orange

warna hijau sama banyaknya dengan warna orange

ooe o

18. Slide pada Microsoft Power Point dapat meningkatkan pemahaman
pemirsa jika ...

backgroundnya memiliki jenis gambar yang sedikit

backgroundnya memiliki jenis gambar yang banyak

backgroundnya memiliki jenis gambar sedikit, jumlahnya banyak

backgroundnya memiliki jenis gambar banyak, warna banyak

backgroundnya memiliki jenis gambar banyak, warna sedikit

o R0 o

19. Siide pada Microsoft Power Point efektif jika memuat ...

kalimat yang ditulis secara lengkap dan jelas

kalimat yang ditulis secara lengkap dan jelas disertai kata kunci
kata kunci yang ditulis secara tersendiri

kata-kata bermakna yang disertai uraian penjelasan

kalimat dan kata-kata bermakna yang dirangkai sebagai kesimpulan

o0 o

20. Tayangan slide pada Microsoft Power Point akan lebih menarik jika ada
unsur gerak saat ...

awal penayangan

pertengahan penayangan

akhir penayangan

awal dan tengah penayangan

tengah dan akhir penayangan

R0 oR

21. Tayangan slide pada Microsoft Power Point akan lebih menarik jika
disertail unsur suara yang ...

lebih rendah dan suara pembicara

sama dengan suara pembicara

lebih dominan dan suara pembicara

kadang dengan suara yang rendah kadang dengan suara yang tinggi

mencerminkan kepribadian pembicara dan pemirsa

- R

22. Agar tayangan bisa dilihat pemirsa yang jumlahnya banyak, maka
diperiukan alat yang biasa disebut LCD sebagai kepanjangan dari. ..
a.  Light Compact Disc
b. Liguid Chyoda Disc
o.  Light Crystal Displuy
Jd Liquid Chyoda Display
e.  Ligquid Crystal Display

PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO
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[€] Microsoft PowerPaint - [Presentationi]

23. Untuk menuliskan suatu kata atau kalimat dalam slide terlebih dahulu
dapat menekan icon nomor . ..

a. 1
b. 2
c. 7
d 8
e 12

24. Untuk membingkai secara bujur sangkar terhadap kata atau tulisan dalam
slide, terlebih dahulu dapat menekan icon nomor ...
a. 4
b. §
c. 6
d 9
e. 10

25, Untuk membingkai secara bundar terhadap kata atau tulisan dalam slide,
terlebth dahulu dapat menekan icon nomor ...
a. 3
b. 6
c. 8
d 11
e 12
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LEMBAR OBSERVASI

Sasaran : Guru Peserta Pelatihan

Observer : Penelitt
Hari. Tgi . b 2006
— S ._ L I
NO PERNYATAAN + SKOR
- VARIABEL KEMAMPUAN GURL (X2) s '31203 16

1. PENGETAHUAN

] Peserta memahami perintah dalam membuat presentasi.
Peserta mengetahut bentuk, ukuran dan warna huruf

dalam Microsaofi PovwerPoin _ o

| Pescrta memahami bahwa Microsoft PowerPomt dapat

l
r
ii' _digunakan dalam mendukung Proses Belajar Mengajar.

1]

|
e e

=X

Peserta memahami bagatmana menilai hasil akhir
_i pembuatan presentasi.

2. SIKAP ' f

) Peserta menerima nilai-nilai respect, re.ij)fr:;t-'hn‘if_}f. - ‘ 1 N "__T_T_m ) |

Peserta bersedia menerapkan nilai-nifai. i 1 _ 1 |

]= 7 Peserta mengkaitkan nilai-nilai respect, responsibility ’ : |

dengan nilai-nilai enjoy ) o | 1 ‘

8 Peserta menvusun selurub nilai-nilai yang dimiliki I |' | | |
menjadi satu kesatuan | | i

.. 9 | Peserta menjadikan nilai-nilai sebagai bagian dirinya. 1 N T R S
i 10 Peserta menerapkan nilai-nilai dalam pembuatan media. : : |
i [ —_ - —_—————— e e— e LA L
3. KETRAMPILAN l
0 Secara re_:ﬂeks peserta terbiasa menombol gambar disket i |
! | agar hasil pekerjaan tersimpan dengan aman. | ! : '1
]» 12 Peserta dapat mengetik dengan komputer. 1 R
’ 13 Peserta dapat membedakan beberapa suara untuk | | i

| melengkapi media presentasi
[ Peserta dapat membedakan beberapa gambar untuk
melengkapi media presentasi o o
Peserta membuat presentasi nidak selalu beruruian baik |

|
... | buruf gambar densuara S
i i

Peserta dapat membuat presentast dalam wakiu singkat

R,

L - L
| denganhasil vang bawus T T
|r 17 | Peserta dapat mengarahkan kursor pada icon sang dituju. 1 - l i
' 18 Peserta tramptl dalam menggunakan kevhoard dan mouse : !

komputer secara bergantian.

- N . | (A
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Keterar an: )
Angka Keterangan ;
e e o
% Sangat Bak .
5 . Bak |
i 2 Cukup y
! Kurang o |
£ Sangat Kurang |

Catatan kejzZian selama observasi berlangsung, sebagai berikut
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LEMBAR OBSERYASI
Sasaran : Siswa peserta pembelajaran
Observer : Peneliti

Hari/ Tgl P A 20006

NO

PERNYATAAN | PILIHAN
VARIABEL PERHATIAN (V) 4 3(271]0

Perhatian siswa lebih terfokus Kketika presentasi
MPP menampilkan tulisan vang hurufnya
berwarna.

. Perhatian siswa lebih terfokus ketika presentasi
- MPP menampilkan gambar yang berwarna

i Perhatian siswa lebih terfokus ketika presentasi

MPP menampilkan tulisan yang susunan
hurafnya lain dari biasanya.

, Perhatian siswa lebih terfokus ketika presentasi ,

' lain dari biasanya.

MPP menampilkan gambar yang susunannva

' Perhatian siswa lebih terfokus ketika presentasi

MPP menampilkan tulisan vang bisa bergerak.

. MPP menampilkan gambar yang bisa bergerak.

Perhatian siswa lebih terfokus ketika presentasi

i berwarna warni.

Perhatian siswa lebih terfokus saat presentasi
MPP karena siswa senang dapat melihat tulisan
atau gambar/ ilustrasi dengan background yang

_atau gambar yang bergerak.

Perhatian siswa lebih terfokus saat presentast
MPP karena siswa senang dapat melihat tulisan

Perhatian siswa lebih terfokus kepada presentasi
MPP karena siswa membutuhkan ilmu
. pengeiahuan dari suatu mata pelajaran.

Perhatian siswa lebih terfokus kepada presentasi
MPP karena untuk memenuh Aebutuban rasa
ingin tahu siswa.

1

Perhatian siswa lebih terfokus kepada presentasi
MPP agar nantinya memudahkan siswa dalam

. R ]

12

Perhatian siswa lebih terfokus kepada presentasi
MPP agar nantinya dapat mengerjakan soal-soal
xlangan.

|

t
mengerjakan tugas-tugas. I

|

|

|

Anghetvasis.: Perhatian PELATIHAN B{NGGUNAAN PROGRAM WIDDY ENDRAYANTO
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Keterangan:
Angka Keterangan |
4 Sangat Baik -
3 Baik
2 Cukup
1 Kurang
0 Sangat Kurang

Catatan kejadian selama observasi berlangsung, sebagai berikut

PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO
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&2
Lampiran : Penghitungan Fuired 1 Test Kemampuan Guru
TABEL PENGHITUNGAN PAIRED { TEST ANTARA KOGNITIF SEBELUM
PELATIHAN DAN SESUDAH PELATIHAN
SEBELUM SETELAH 2
NO PELATIHAN | PELATIHAN| O] R (1.6
01 0? (02-01)
! 9 15 6 36 0 0
2 9 14 5 25 -1 ]
3 8 14 6 36 0 0
4 9 |5 6 36 0 O
5 7 14 7 49 | |
6 9 14 5 25 -1 }
7 9 I3 6 I6 0 0
8 8 I3 7 49 | ]
9 8 15 7 49 1 l
10 9 16 7 49 ! 1
r= 85 |Z= 147 62 390] T= 6
X= 85 |Y= 147[06= 4 |[H= 39
(= Gl - Hol
SDa [ ~Nn
6 - 39
i = ,
0.82 I 316
-33
t = —
0,26
t = -127,03
Lihat pada tabel.
df = G
Q= 0,05
t tabel = 2,132

t Hit < t Tabel, maka Ho Ditolak
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TABEL PENGILLEUNGAN P URED ETENT ANTARA AFERK CLF SESERLA PELATHIAN
DANSESUDAH PELATIHAN

SEBLELL M OSETELAH 1 | ) i
. 0 : . . . [43 ol — -
PELATIHAN 0 FELATIHA Y [ 2
| MO -0 [ (61-6)
B [ foomerimm s eem e o i i
; O - 02 lUl-UIJ l
S B T i 9 T -
2 s : 2 7 I o Kl
:_ ; [RE t : 8!
SN U B A b !
R M +) hE |
_ (\_ o |‘\__ }_ - :‘il_.l e B _I':.-'l 1
| ot v ey ! N
h ! [ Y e Lt 8]
u ; A ) G . 0
ik ' 5 A [1i Lt [
P lo - J— R - —
. :
- i — A —
= P18 Y= 204 S0 ERn! = |7
— - . |['—
N\ it Y= 204|C0= v |l 7 l
1 ol - uol
Sho v N
v .
1 — UL " =
137 a6
67
t -
s
(I -133.740

Lihat puada tabel,

di Y
Q iy s
( tubel = 2,132

t Hit < ¢ Tabel, maka Ho Ditolak
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84
TABEL PENGHITUNGAN PAIRED ¢ TEST ANTARA PSIKOMOTORIK SERELUM
PELATIHAN DAN SESUDAH PELATIHAN
NO SEBELUM SETELAH 61 612
PELATIHAN | PELATIHAN G1-6 | (61.6 )z
01 02 (02-01)
1 16 27 1 121 -1 1
2 16 30 14 196 2 4
3 18 30 12 144 0
4 16 28 12 144 0 0
5 18 28 10 100 -2 4
6 15 28 13 169 1 1
7 19 31 12 144 0 0
8 16 28 12 144 0 0
9 15 28 13 169 ! 1
10 17 31 14 196 2 4
L= 166 [L= 289 123 1527 = 15
X= 166)]Y= 29 |0= 12|U= 53
( = Gl . I_L gl
SDol / +n
. = 12 - 153
1,29 /3,16
t = _ﬂ_
0,41
t = -34391
Lihat pada tabel.
df = 9
a= 0,05
ttabel = 2,132

t Hit < t Tabel, maka Ho Ditolak
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TABEL PENGHITUNGAN PAIRED ¢ TEST ANTARA PBM SEBELUM MENGGUNAKAN
MICROSOFT POWERPOINT DAN PBM SETELAH MENGGUNAKAN MICROSOFT

POWERPOINT
SEBELUM SETELAR — -
NO | PELATIHAN | PELATIHAN G1i G112 61-6 | (61-0 )2
{01) (02) (02 - O1)

1 21 39 18 324 310 96.100
2 17 36 19 361 347 120,409
3 21 42 21 44] 427 182.329
4 27 35 8 64 50 2.500
5 20 38 18 324 310 96.100
6 27 39 12 144 130 16.900
7 23 39 16 256 242 58.564
8 20 34 14 196 182 33.124
9 15 32 17 289 275 75.625
10 23 37 14 196 182 33,124
11 17 36 19 361 347 120.409
12 22 36 14 196 182 33.124
I3 20 33 13 169 155 24.025
14 24 36 12 144 130 16,900
15 21 39 18 324 310 96.100
16 20 33 13 169 155 24.025
17 28 39 n 121 107 11.449
18 20 32 12 144 130 16.900
19 26 44 18 324 310 96.100
20 21 45 24 576 562 315.844
21 25 41 16 256 242 58.564
22 23 39 16 256 242 58.564
23 22 37 15 225 211 44.521
24 24 35 11 121 107 11.449
25 24 38 i4 196 182 33.124
26 17 31 14 196 182 33.124
27 20 38 18 324 310 96.100
28 20 37 17 289 275 75.625
29 22 36 14 196 182 33.124
30 24 41 17 289 275 75.625
3 24 38 14 196 182 33.124
32 26 36 10 100 86 7.396
33 20 32 12 144 130 16.900
34 25 38 13 169 155 24.025
38 21 42 21 441 427 182.329
36 21 37 16 256 242 58.564
37 18 34 16 256 242 58.564
38 25 35 10 100 86 7.396
39 15 31 16 256 242 58.564
40 23 38 15 225 211 44,521

TESIS
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41 23 3] 8 64 50 2.500
42 19 40 2} 441 427 182,329
43 22 14 22 - 484 470 220.900
44 20 34 14 196 182 31124
45 22 41 19 36i 347 120.409
46 20 36 16 258 242 58.564
47 26 42 16 256 242 58.564
48 23 42 i9 361 347 120.409
49 28 43 15 225 211 44521
50 28 43 N 223 21l 44521
51 30 47 17 28¢ 275 75625
52 24 36 2 142 130 6.900
53 19 35 16 25¢ 242 58.564
54 24 42 18 32+ 310 96100
55 31 41 10 100 86 7.396
56 25 38 13 16 153 24.025
57 34 a4 10 100 86 7.396
58 26 42 16 25¢ 242 58.564
59 25 32 7 49 35 1.225
60 25 37 12 14 130 16.900
61 23 <3 21 44: 427 182.329
62 24 33 9 8! 67 4.489
63 27 ) 17 28¢ 275 75.625
64 26 41 15 22: 21 44.521
65 28 + 13 16+ 155 24 025
66 25 42 17 28« 275 75.625
67 25 i6 il 121 107 11,449
68 23 4 24 576 562 115844
69 28 39 11 12: 157 I1.449
70 25 38 13 16% 135 24.025
71 23 45 22 48+ 470 220.900
72 22 39 17 28% 275 75.625
73 24 + 17 28¢ 275 75.625
74 16 a2 16 25¢ 242 58.564
75 24 45 2] 44} 427 182.329
76 23 33 20 400 286 148.996
77 19 10 21 44 427 £82.329
78 18 33 17 28< 275 75,625
79 24 3 17 28¢ 278 75.625
80 26 =1 15 pAN Y 44521
81 28 39 11 2] N7 11.449
82 22 4] 1% 36! a7 120.409
83 19 35 i6 25¢ 242 58.564
84 25 42 17 28¢ 278 75625
85 25 40 15 225 2L 44.521
86 29 42 i3 I6& 155 24.025
87 23 EN 12 144 130 16.900
88 20 38 18 324 30 96.100
89 27 BN 8 64 0 2 500
90 26 43 17 28¢ 275 75625
TESIS PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO
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91 25 39 14 196 182 33.124
92 26 35 9 81 67 4.489
93 24 35 11 - 121 107 11.449
94 28 38 10 100 86 7.396
95 28 42 14 196 182 33,124
9 26 40 14 196 182 33.124
97 20 36 16 256 242 58.564
98 23 38 E 225 211 44.521
99 20 38 18 324 310 96.100
100 28 39 1] 121 107 11,449
101 33 36 3 9 -5 25
102 27 38 1] (21 107 11.449
103 28 44 16 256 242 58.564
104 32 40 8 64 S0 2.500
105 23 33 10 100 86 7.396
106 22 35 13 169 155 24.025
107 25 42 17 289 275 75.625
108 19 34 B 225 211 44.52]
109 23 38 [< 225 211 44.521
110 25 38 i3 169 155 24.025
1T 29 43 14 196 182 33.124
112 22 44 22 434 470 220.900
113 29 45 16 256 242 58 564
114 24 40 16 256 242 58,564
1S 25 41 16 256 242 58.564
116 18 32 14 196 182 33.124
117 18 36 18 324 310 96.100
118 22 34 12 144 130 16,900
119 26 42 16 256 242 58.564
120 24 43 19 361 347 £20.409
121 28 38 10 100 86 7.396
122 27 43 16 256 242 58.564
123 20 35 i3 225 211 44,521
124 22 42 20 400 386 148 996
125 23 37 14 196 182 33.124
126 25 36 1} 121 107 11,449
127 24 42 18 324 310 96.100
128 27 40 13 169 155 24.025
129 20 33 13 169 155 24,025
130 17 34 17 289 275 75.625
131 24 39 15 225 211 44 521
132 2 32 11 121 107 11.449
133 24 35 ! 121 107 11 449
134 22 37 1% 225 211 44 521
135 14 34 20 400 386 148 996
136 22 33 i 121 107 11.449
137 26 39 13 169 155 24,025
138 23 37 3 196 182 33.124
139 22 35 13 [69 155 24,025
140 25 37 E 144 130 16,900
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141 15 34 19 361 347 120 409
[42 25 41 16 256 242 58.564
143 23 37 14 - 196 182 33.124
144 26 37 11 121 107 11.449
145 15 40 25 625 611 373.321
146 24 41 17 289 275 75.625
147 30 44 14 196 182 33.124
48 19 34 15 223 211 44.521
149 23 40 17 289 275 75.625
150 24 34 10 100 86 7.396
151 22 42 20 400 386 148.996
152 26 39 i3 169 155 24.025
133 17 34 17 289 275 75.625
154 23 41 18 324 3o %6100
155 24 42 18 324 310 96.100
156 26 39 13 169 155 24.025
157 27 40 13 169 155 24,025
158 27 41 14 196 182 33.124
159 18 33 15 225 211 44521
160 24 39 15 225 21t 44.521
161 27 44 17 289 275 75,625
[62 20 34 14 196 182 33.124
163 21 34 13 169 155 24,025
164 25 29 4 16 2 4
163 26 38 12 144 130 16,900
166 22 37 15 225 211 44.521
167 27 37 10 100 86 7.396
168 22 34 12 144 130 16.900
169 26 37 11 12t 107 11.449
170 30 40 10 100 86 7.396
171 25 16 11 121 107 11.449
172 18 34 16 256 242 58564
173 26 39 13 169 155 24.025
174 26 35 G 81 67 4.489
175 22 36 14 196 182 33.124
176 28 40 12 144 130 16.900
177 29 39 10 100 86 7.396
178 21 36 14 196 182 33.124
179 30 41 11 121 107 11.449
180 25 35 10 130 B6 71.396
181 25 38 13 169 155 24025
182 27 42 5 225 211 44.521
183 27 37 10 100 86 7.396
184 23 41 18 324 310 96.10{)
185 25 42 17 289 275 75.625
186 22 42 20 400 386 148,996
187 29 38 9 81 67 4.489
188 30 36 6 36 22 434
189 28 39 1 121 107 11.449
190 22 36 14 196 182 33.124
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161 25 35 10 100 86 7.396
152 25 41 16 256 242 58.564
193 24 40 16 256 242 38.564
194 29 42 13 169 155 24.025
195 24 36 12 144 130 16.900
196 23 37 14 196 182 33.124
167 25 38 13 169 155 24.025
i98 26 42 16 256 242 58.564
159 28 36 8 64 50 2.500
200 27 38 |1 121 107 11.449
201 19 38 | 361 347 120.409
202 27 38 ! 121 107 11.449
203 20 34 14 156 182 33.124
204 23 38 15 225 211 44.521
203 31 41 10 100 26 7.396
206 15 34 15 225 211 44.521
207 25 19 14 196 182 33.124
208 21 37 16 256 242 58.564
209 28 39 Il 121 107 L1.449
210 21 35 14 196 182 33.124
211 25 36 11 12} 107 11.449
212 30 40 10 100 86 7.396
213 31 38 7 49 35 1.225
214 29 35 6 36 22 484
215 20 38 18 324 310 96,100
216 23 40 17 289 275 75.625
217 24 39 15 225 211 44.521
218 25 38 13 169 155 24.025
219 24 38 14 196 182 33.124
220 27 37 16 100 86 7.396
221 21 4] 20 400 386 148.996
222 22 32 10 100 86 7.396
223 28 39 11 121 107 11,449
224 30 39 9 81 67 4.489
225 22 42 20 400 386 148.996
226 28 36 8 64 50 2.500
227 22 37 15 225 211 44.521
228 25 33 i3 169 155 24.025
229 29 44 15 225 211 44.521
230 22 43 21 441 427 182.329
231 24 35 tHl 121 107 11.449
232 29 46 17 289 275 75.625
233 28 45 17 289 275 75.625
234 22 38 16 256 242 58.564
235 23 40 17 289 275 75.625
236 29 39 10 100 86 7.396
237 i9 35 16 256 242 58.564
238 30 33 3 9 -5 23
239 25 31 6 36 22 484
240 25 41 16 256 242 58.564
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241 24 38 14 196 TE 33 124
i 20 1] 17 JEY IS TS 025
243 26 1o 10 100 Ko 739
244 26 36 10 100 86 739
245 74 35 1 121 107 11449
246 26 13 7 389 275 75.625
247 20 33 14 196 182 33.124
248 28 36 3 64 50 2,500
249 25 38 13 (69 135 24 025
250 20 35 s 225 20 44 521
251 21 34 13 169 155 24.025
252 23 33 10 100 86 739
253 20 30 20 400 386 148 996
254 23 13 20 300 386 148.996
235 25 37 12 144 130 16 900
256 19 3] 12 144 130 16.900
257 23 4 18 324 310 96.100
258 21 38 17 289 275 75.625
259 28 39 i 121 107 11.449
260 17 36 T 0] 347 120 409
261 24 36 12 144 130 16.900
262 23 39 T 756 242 38.564
L= 6255 [ L= 9989[ 3734 56894] £= | 13.868.166
X= 23874] Y= 381[6= 14 [p- 217
t = Tg1l - jol
SDo | Vi
= 14 - 217
23051 16,19
t = =203
14.24
t = 14,258
Lihat pada tabel.
df = 261
a= 005
ttabel = 1,645

t Hit < t Tabel, maka Ho Ditolak
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Lampiran: Analisis terhadap Aspek Perhatian Siswa.

i. Hasil Penilaian Siswa terhadap Aspek Perhatian (Versi {-riedman Test).

1.1. Penilaian Siswa terhadap Empat Aspek Objek Perhatian.

Tabel 5.3 Ranks

Mean Rank
™ 2,34
GW 2,54
TG 262
GG 2,50

Tabel 5.4 Test Statidtics

N 262
Chi SWquate 11,724
df K]
Asymp. Sig. 008

a. Friedman Test

1.2. Penilaian Siswa terhadap Empat Aspek Subjek Perhatian.

Tabel 5.5 Ranks

Mean Rank
SW 264
SG 245
Bi 2.5
TT 2,40

Tabel 5.6 Test Statidtics

N 262
Chi-Square 7,007
df 3
Asymp. Sig. 072

a. Friedman Test

TESIS PELATIHAN PENGGUNAAN PROGRAM WIDDY ENDRAYANTO




IR-PERPUSTAKAAN UNIVERSITAS AIRLANGGA 92

2. Hasil Kesepakatan Siswa terhadap Aspek Perhatian

iVerst KNendad! s 1 fean

Tabel 5.17 Ranks

Mean Rank
TW 4735
Gw 475
TG 4,92
GG 4 66
SW 4,64
SG 4722
a8l 4,35
T 4 11

Tabel 5.18 Test Statistics

N 262
Kendall's W? 018
Chi-Square 33,676
df 7
Asymp. Sig. 000

a. KendaW's Coefficient of Concordance
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